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Chapter 1 Introduction

This document describes the features, specifications, and operating functions of 
the PowerDNA® for SoloX Cube and RACK data acquisition systems. Each 
system contains a SoloX CPU/Power core module and is designed for use with 
a Gigabit Ethernet 1000Base-T communication network. Cube and RACK 
versions differ in their form factor and the number of I/O boards supported. 
This chapter provides the following information:

• Organization of this Manual (Section 1.1)

• Product Versions Described in This Manual (Section 1.2)

• Manual Conventions (Section 1.3)

• Related Resources (Section 1.4)

1.1 Organization 
of this Manual

This “PowerDNA for SoloX Cube & RACK Data Acquisition Systems User 
Manual” is organized as follows:

• Introduction
Chapter 1 describes the organization of the document and the conven-
tions used throughout the manual.

• PowerDNA SoloX RACK System
Chapter 2 provides an overview of hardware for PowerDNA SoloX sys-
tems in a RACK, HalfRACK, and FLATRACK chassis.

• PowerDNA SoloX Cube System
Chapter 3 provides an overview of hardware for PowerDNA SoloX sys-
tems in a Cube chassis.

• Installation and Configuration
Chapter 4 summarizes the recommended procedures for installing, con-
figuring, starting up, and troubleshooting a SoloX Cube/Rack.

• PowerDNA Explorer
Chapter 5 provides a general description of the capabilities of UEI’s
GUI-based communication application, PowerDNA Explorer, when used
with a SoloX Cube/Rack.

• Programming CPU Parameters
Chapter 6 describes the SoloX CPU/Power core module(s) within a
SoloX Cube/Rack.

• SoloX Accessories
Appendix A provides a list of cable and screw terminal panel accesso-
ries available for interacting with the SoloX CPU core module.

• Network Interface Card Configuration
Appendix B describes procedures for installing and configuring Ethernet
cards for use with Windows operating systems.

• Field Replacement of Fuses
Appendix C describes procedures for replacing fuses on DNA and DNR
boards.
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1.2 Product 
Versions 
Described in 
This Manual

This manual provides information for the following products:
• PowerDNA SoloX Cube systems

(referred to collectively as “DNA-PPCx-1G-11”):
• UEINet-11 supports 1 I/O board
• DNA-PPC5-1G-11 supports up to 3 I/O boards
• DNA-PPC8-1G-11 supports up to 6 I/O boards
• DNA-PPC9-1G-11 supports up to 7 I/O boards

• PowerDNA SoloX RACKTM systems 

(referred to collectively as “DNR-x-1G-11”):

• DNF-4-1G-11 FLATRACKTM supports up to 4 I/O boards

• DNR-6-1G-11 HalfRACKTM supports up to 6 I/O boards

• DNR-12-1G-11 RACKtangleTM supports up to 12 I/O boards
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1.2.1 Comparison 
with Other 
Product 
Versions

Table 1-1 compares the PowerDNA SoloX Cube/Rack system with earlier 
generations of the PowerDNA Cube/Rack. 
Earlier generations are indicated by option numbers -00/-01, -02, or -03 (e.g., 
DNR-12-1G, DNR-12-1G-02, or DNR-12-1G-03). SoloX products are indicated 
by option number -11 as shown in the list above (e.g., DNR-12-1G-11).
For users transitioning between the two, the SoloX version simply swaps out the 
CPU/Power core module on the 8347-based version. The chassis, software, I/O 
boards, and all other system components are identical.

1. 1PPS and IEEE-1588 synchronization support is described in the “PowerDNx 1PPS Sync Interface Manual”.
2. RAM and flash memory are not user-accessible on PowerDNA (hosted) deployments. Portions of RAM and flash are 
available on UEIPAC, UEISIM, UEIModbus, and UEIOPC-UA (stand-alone) deployments.

PowerDNA Cube/RACK hardware may be upgraded to one of UEI’s stand-
alone systems:

• UEIPAC XXX-1G - Programmable Automation Controller

• UEISIM XXX-1G - Simulink / Simulink Coder Target

• UEIModbus XXX-1G - Modbus TCP-based Controller

• UEIOPCUA XXX-1G - OPC-UA Server, accessed by any OPC-UA client

Table 1-1 Summary of DNA-PPCx-1G and DNR-x-1G Product Versions

Option No. Processor Summary of Features

-00/-01
-02
-03

8347

• Freescale MPC8347 PowerPC CPU @400MHz
• 10/100/1000Base-T Ethernet interface

• 1PPS and IEEE-1588 synchronization support1

• Up to 256 MB RAM2

• Up to 128 MB flash memory2

• RS-232 interface through DSUB-9
• All I/O boards supported

-11 SoloX

• NXP i.MX6 SoloX Series ARM dual-core CPU: 
Cortex-A9 @1GHz and Cortex-M4 @200MHz

• 10/100/1000Base-T Ethernet interface

• 1PPS and IEEE-1588 synchronization support1

• 1 GB RAM2

• 8 GB flash memory (& U-boot QSPI flash)2

• Dual RS-232 interface (one per CPU core) through DSUB-15
• All I/O boards supported
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1.3 Manual 
Conventions

The following conventions are used throughout this manual: 

Tips are designed to highlight quick ways to get the job done or to reveal
good ideas you might not discover on your own.

CAUTION! advises you of precautions to take to avoid injury, data loss,
and damage to your boards or a system crash.

NOTE: Notes alert you to important information.

1.4 Related 
Resources

Additional documentation is included with the PowerDNA software installation. 
On Windows, these resources can be found from the desktop by clicking Start » 
All Programs » UEI
UEI’s website includes other user resources such as application notes, FAQs, 
tutorials, and videos. In particular, the glossary of terms may be helpful when 
reading through this manual: https://www.ueidaq.com/glossary
Additional questions? Please email UEI Support at support@ueidaq.com or call 
508-921-4600.

Typeface Description Example
bold field or button names Click Scan Network
» hierarchy to get to a specific menu item File » New 
fixed source code to be entered verbatim session.CleanUp()

<brackets> placeholder for user-defined text pdna://<IP address>

italics path to a file or directory C:\Program Files

https://www.ueidaq.com/glossary
https://www.ueidaq.com/glossary
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Chapter 2 PowerDNA SoloX RACK System

This chapter provides the following information about PowerDNA SoloX RACK 
system hardware (DNR-x-1G-11):

• SoloX RACK Overview (Section 2.1)

• Specifications (Section 2.2)

• Key Features (Section 2.3)

• RACK Enclosures (Section 2.4)

• CPU/POWER Module (Section 2.5)

• DNR/DNF Power Module (Section 2.6)

• DNR-Buffer Module (Section 2.7)

• RACK I/O Boards (Section 2.8)

2.1 SoloX RACK 
Overview

The PowerDNA SoloX RACK is a Gigabit Ethernet-based data acquisition 
system housed in a rack-mounted chassis.
PowerDNA SoloX RACK versions differ in the number of supported I/O boards:

• DNF-4-1G-11 FLATRACKTM accepts up to 4 user-selected I/O boards

• DNR-6-1G-11 HalfRACKTM accepts up to 6 user-selected I/O boards

• DNR-12-1G-11 RACKtangleTM accepts up to 12 user-selected I/O
boards

Figure 2-1  DNR-12-1G-11 RACKtangle System

DNR Power Module SoloX CPU/POWER Module Buffer Module (DNR-12-1G-11 only)

up to 12 I/O Boards
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Figure 2-2  DNF-4-1G-11 FLATRACK System

2.1.1 RACK System 
Components

A standard PowerDNA SoloX RACK system consists of the following modules:

Module locations are shown in Figure 2-1 and Figure 2-2. 
The SoloX CPU/POWER module controls the unit’s operations and supervises 
the activity of the I/O boards. System power is managed by the CPU/POWER 
module as well as a separate DNR/DNF Power module. DNR-12-1G 
RACKtangle systems also include a Buffer module to guard against data loss 
between the I/O boards and CPU.
The remaining slots in the RACK are dedicated to user-selected I/O boards. To 
configure a complete data acquisition system, specify up to 4 DNF I/O boards for 
installation into a FLATRACK, up to 6 DNR boards or a HalfRACK, or up to 12 
DNR boards for a full RACKtangle.
For module part numbers, refer to Table 2-4.
For detailed descriptions of all I/O boards and accessories available for the 
PowerDNA SoloX RACK, refer to www.ueidaq.com.

up to 4 I/O boards

DNF Power Module

SoloX CPU/POWER Module

Table 2-1 PowerDNA SoloX RACK Components

QTY Item Refer to Section

1 RACKtangle, HalfRACK, or FLATRACK enclosure Section 2.4

1 SoloX CPU/POWER module

1 DNR/DNF Power module

1 Buffer Module (only used with RACKtangle chassis)

up to 12 Your selection of DNR- or DNF- series I/O boards

optional Blank filler panels, one for each unused I/O slot
Note: Slot covers are optional and not included in the price of the 
RACK.

1 DNA-PSU-180 180-Watt, 120/230 VAC to +24 VDC external 
power supply with cable and Molex connector
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2.2 Specifications Table 2-2 lists the technical specifications for the PowerDNA SoloX RACK:

1. Dimensions are given as lengthbase × widthbase × height.

2. Only user-accessible on UEIPAC stand-alone deployments
3. Shock and vibration specifications assume appropriate mounting/installation.

Table 2-2 PowerDNA SoloX RACK Specifications
Computer Interface
Primary Ethernet port 10/100/1000Base-T, RJ-45 connector
Diagnostic port 10/100/1000Base-T, RJ-45 connector
Config/Serial port Dual RS-232 ports, one per CPU core

Synchronization options

1. DNA-SYNC-1G series cables and boards provide 
both clock and trigger signals
2. DNA-IRIG-650 board for IRIG and GPS sync
3. IEEE-1588 sync

I/O Slots and Dimensions1

DNF-4-1G-11 4 slots (1.75” x 7.8” x 16”, Std 1U)
DNR-6-1G-11 6 slots (5.25” x 6.2” x 10.5”)
DNR-12-1G-11 12 slots (5.25” x 6.2” x 17.5”, Std 3U)
Host Communications
Distance from host 100 meters max, CAT5+ cable
Ethernet data transfer rate 20 megabytes per second
Processor

CPU SoloX i.MX6 series dual core ARM processor
Cortex A9 core @ 1GHz, Cortex M4 @ 200 MHz

Memory 1 GByte RAM1

FLASH memory 8 GByte1

Solid-state hard drive not supported on PowerDNA deployments2

µSD card interface not supported on PowerDNA deployments2

USB port not supported on PowerDNA deployments2

Environmental
Electrical Isolation 350 Vrms
Temp (operating) -40 °C to +70 °C
Temp (storage) -40 °C to +85 °C
Humidity 0% to 95%, non-condensing

Vibration3  IEC 60068-2-6
                  IEC 60068-2-64

3 g, 10-500 Hz, sinusoidal 
3 g (rms), 10-500 Hz, broadband random

Shock3      IEC 60068-2-27
100 g, 3 ms half sine, 18 shocks @ 6 orientations
30 g, 11 ms half sine, 18 shocks @ 6 orientations

Altitude 70,000 feet, maximum
Power Requirements
Voltage 9-36 VDC (115/220 VAC adaptor included)
Power 10 Watts (not including I/O boards)
Reliability
MTBF >130,000 / 160,000 hours for DNR-12 / DNR-6
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2.3 Key Features The following table is a list of key features of the PowerDNA SoloX RACK 
system.

Table 2-3 PowerDNA SoloX RACK Features

Easy to Configure and Deploy

• Over 80 different I/O boards available

• Built-in signal conditioning

• Bracket kit for mounting to wall or in 19” racks

• Industrial quality rubber feet for solid table-top
mounting

• Passive backplane ensures extremely low MTTR

• Standard “Off-the-shelf” products and delivery

Flexible Connectivity

• Dual 1000Base-T Gigabit Ethernet ports with inde-
pendent IPs (100/10Base-T compatible)

• RS-232 interface

High Channel Density
A RACK with 12 I/O boards supports:

• Analog Inputs: up to 300 channels

• ICP/IEPE: up to 48 channels

• Analog Outputs: up to 384 channels

• Digital I/O: up to 576 channels

• ARINC-429: up to 192 channels

• Counter/Timer: up to 96 channels

• CAN-bus: up to 48 ports

• RVDT/LVDT: up to 48 channels

• RS-232/422/485: up to 96 ports

• Synchro/Resolver: up to 48 channels

• MIL-1553: up to 24 redundant ports

Rugged and Industrial

• All Aluminum construction

• Operation tested from -40°C to 70°C

• Vibration tested to 3 g (operating)

• Shock tested to 100 g (operating)

• All I/O isolated from Cube and host PC

• Operation to 70,000 feet

• Fans included

True Real-time Performance

• 1 millisecond updates guaranteed with 1000 I/O

• Up to 6 million samples per second

• Use QNX, RTX, VxWorks

Outstanding Software Support

• Windows, Linux, RTX, VxWorks, and QNX operating
systems

• VB, VB.NET, C, C#, C++, Python

• MATLAB, LabVIEW, OPC, ActiveX support
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2.4 RACK 
Enclosures

The RACK enclosures are rigid mechanical structures with complete EMI 
shielding (see Figure 2-3, Figure 2-4, and Figure 2-5 below). The enclosure 
houses the following components:

Table 2-4 Modules in PowerDNA SoloX RACK Enclosure

Item Part No. Description

Power board DNR-POWER-DC DNR-12 and DNR-6: Isolated DC/DC Power Module/Power 
Monitor with status indicators, a local on/off switch, and 4-
pin Molex Power-In connector.

DNF-POWER-DC 
or
DNF-POWER-AC

DNF-4, DC: Mounting plate & connecting hardware 
or
DNF-4, AC: Mounting plate, connecting hardware, and 9-36 
VDC power supply for use with -AC

CPU / POWER 
module

DNR-CPU-1G-11
DNF-CPU-1G-11

One dual-slot CPU / POWER module 

Buffer board DNR-BUFFER
(RACKtangle only)

DNR-12: One for buffering address/control/clock lines (not 
currently addressable).
Not applicable for DNR-6 and DNF-4 

I/O boards DNR- / DNF- RACK I/O boards designed for front removal and installation. 

Enclosure DNR-BP-6
DNR-BP-6
DNF-4-ENCL

One backplane/assembly with temperature sensors

Filler panels DNR-IO-FILLER
DNF-IO-FILLER

Blank filler panels for all unused slots (Note that this item is 
optional / not included in price of rack) 

Fans 8-volt cooling fans mounted in enclosure 
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2.4.1 DNR-12-1G 
Enclosure

The exploded view of a DNR-12-1G RACKtangle enclosure is shown below in 
Figure 2-3. A parts list is provided in Table 2-5 on the next page. 

Figure 2-3  Typical RACKtangle Enclosure (Exploded View)

NOTE: The rightmost module (I/O board slot 12) is 2-slots wide to 
accommodate future designs and/or custom modules.

The enclosure has reversible mounting flanges designed for rack or surface 
mounting. Rubber feet are supplied for desktop or tabletop mounting. Refer to 
Section 4.8 on page 61 for more information about mounting options and field 
connections. 
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Table 2-5 DNR-12-1G RACKtangle Enclosure Part List (see Figure 2-3)

Item No. Quantity Description

1 1 Enclosure, UEIPAC 1200R 2000-241A

2 1 Rear Panel, UEIPAC 1200R 2000-242A

3 2 Bracket, MOUNTING, STEEL, DNR-12 2000-0033 X

4 1 Assembly, PCB, BACKPLANE, DNR-12 DNR-12BP

5 4 Spacer, FAN, 60MM 2004-6060

6 4 Fan, AXIAL, 60x10mm, 12VDC . DNR-FAN

7 4 Filter Assembly, 60mm, 45PPI 806-5023

8 4 Bumper, RECESSED, 3/4DIA, 7/16H 1000-728

9 16 Screw, #4-40x¼,82° FH,PHIL,SST,BLK OXIDE 1001-082

10 12 Screw, #4-40x.250,PAN HD,PH,SEMS,SQ CONE 1001-028

11 4 Screw, #6-32x.375,100D FH,PHIL,SST,BLK OXIDE 1001-375 X

12 4 Screw, #6-32x.437,PAN HD,PHIL,SEMS,EXT 1001-437

13 16 Screw, #6-32x1.00,82° FH,PHIL 1001-635

14 16 Nut, HEX, KEPS, #6-32 1001-634

15 1 IO Filler, DNR-12 2000-0101

16 2 Mount, CABLE TIE 1000-214

17 2 Cable Tie 1000-213
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2.4.2 DNR-6-1G 
Enclosure

The exploded view of a DNR-6-1G HalfRACK system is shown below in Figure 
2-4. A parts list is provided in Table 2-6 on the next page. 

Figure 2-4  Typical HalfRACK Enclosure (Exploded View)

NOTE: The rightmost module (I/O board slot 6) is 2-slots wide to accommodate 
future designs and/or custom modules.

Rubber feet are supplied for desktop or tabletop mounting. Refer to Section 4.8 
on page 61 for more information about mounting options and field connections. 
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Table 2-6 DNR-6-1G HalfRACK Enclosure Parts List (see Figure 2-4)

Item No. Quantity Description

1 1 Enclosure, UEIPAC 600R Base

2 1 Rear panel, UEIPAC 600R

3 1 Assembly, PCB, BACKPLANE, DNR-6 

5 3 Filter Assembly for Fans, 60mm, 30PPI QUALTEK

6 3 Spacer, FAN, 60MM

7 12 Screw, #4-40x¼,82D FH,PHIL,SST,BLK OXIDE

8 10 Screw, #4-40x.250,PAN HD,PH,SEMS,SQ CONE

9 12 Screw, #6-32x.875,82D FH,PHIL

10 4 Screw, #6-32x.437,PAN HD,PHIL,SEMS,EXT

11 2 Screw, #6-32x.437,82D FH,PHIL

12 12 Nut, HEX, KEPS, #6-32

13 4 Bumper, RECESSED, 3/4DIA, 7/16H

14 1 Handle, FLAT
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2.4.3 DNF-4-1G 
Enclosure

The exploded view of a DNF-4-1G FLATRACK system is shown below in Figure 
2-5. A parts list is provided in Table 2-7 on the next page.
The FLATRACK is available in AC or DC powered versions. The DC version 
requires a DC power source between 9 and 36 Volts. The AC unit operates from 
100 to 240 VAC, from 50 to 60 Hz. The power module provides output voltages 
of 24, 3.3, 2.5, 1.5, and 1.2 VDC for the logic/CPU and 8 VDC to power 3 cooling 
fans.
 

Figure 2-5  Typical FLATRACK Enclosure (Exploded View)
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Table 2-7 DNF-4-1G FLATRACK Enclosure Parts List (see Figure 2-5)

Item 
No. 

Quantity 
(AC version)

Quantity
(DC version) Description (Vendor/Vendor Part No.)

1 1 1 Chassis, DNF-4-1G Base

2 1 1 Chassis, DNF-4-1G Cover

3 1 1 Support, DNF-4-1G Backplane

4 2 2 Bracket, Mounting, 19" RACK, DNF-4-1G

5 1 1 Backplane Assembly, PCB, DNFBP4-RA DNFBP4-RA

6 1 1 Power Switch, Rocker, SNAP-IN, 2A 250VAC ITT 
DA102J12S215PQF

7 3 3 Fan, Axial, 40x10mm

8 3 3 Filter Assembly, 40MM FAN QUALTEK 09150-F/30PPI

9 18 14 Screw, #4-40x.250, PAN HD, PH, SEMS, SQ CONE 1001-028

10 25 25 Screw, #4-40x¼,82° FH,PHIL,SST,BLK OXIDE 1001-082

11 8 8 Screw, #6-32x.375,100D FH,PHIL,SST,BLK OXIDE 1001-375

12 6 6 Screw, M3.9x1.2 x 10.5mm, FH, PHIL, FAN MOUNT PENCOM 
M3.9 X 10.5mmPHFL-FAN-NI

13 1 NA Plate, Mounting, CUI POWER SUPPLY 2000-0178

14 2 NA Screw, Oval Head, #4-40 X .250, SLT/Z MCMASTERCARR 
91802A106

15 3 NA Nut, Hex, KEPS, #8-32

16 1 NA Connector, AC Inlet, IEC 320 SCHURTER 6100-3300

17 1 NA Power Supply, 60W, 24VDC, 2"X4" CUI INC VMS-60-24

18 NA 1 Connector, RCPT, MINI CIRC DIN, 4P CUI SD-40LS

21 NA 1 Plate, Mounting, CUI POWER SUPPLY 2000-0184
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2.4.4 Filler Panel & 
Mounting 
Bracket

The following section provides drawings for the DNR-IO-FILLER and 
DNR-BRACKET.

Figure 2-6  Optional DNR-IO-Filler Panel for Empty Slots

Figure 2-7  DNR-BRACKET Reversible Mounting Bracket

Grounding
Fingers

Turn bracket upside down
to use as surface or flange
mounted device
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2.4.5 RACK Air 
Flow

As shown below in Figure 2-8, cooling air is drawn into the rear of the enclosure 
via fans, routed forward over the electronic circuit boards, up to the top of the 
enclosure, and then out the top rear of the enclosure. The system is designed to 
maintain positive pressure cooling within the enclosure at all times.

Figure 2-8  Example of DNR-12-1G RACKtangle Air Flow

Two sensors mounted on the backplane over the Power Module and over the 
CPU board continuously monitor internal temperatures, turning fans on if the 
internal temperature exceeds 45°C, off if it falls below 45°C, and shutting down 
power if a high limit is exceeded.
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2.5 CPU/POWER 
Module

The core module on the PowerDNA SoloX RACK is a 2-board CPU/POWER 
module (DNR-CPU-1G-11). One board is dedicated to CPU functions and the 
other is dedicated to power management.

• The CPU board is based on the NXP i.MX6 SoloX processor. It uses an
Altera/Intel FPGA to communicate with the I/O boards in the chassis.

• The POWER board is a dedicated DC/DC source and control system.
For RACK-based systems, there is an additional power module located
in slot 1 of the DNR-6-1G and DNR-12-1G RACKtangle enclosure or at
the rear of the DNR-4-1G FLATRACK enclosure.

Figure 2-9  SoloX CPU/POWER Module (DNR-CPU-1G-11)

32-bit 66 MHz Bus

CPU Board

POWER Board*

*RACK-based systems include an additional power module (DNx-POWER), which is 
not shown.
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CPU/POWER module components are shown in the functional block diagram in 
Figure 2-10 and described in Section 2.5.1 through Section 2.5.9.

Figure 2-10  Block Diagram of SoloX CPU Module (DNx-CPU-1G-11)

2.5.1 CPU 
Processor

The CPU module centers around an NXP i.MX6 SoloX processor, which is a 
low-power, dual-core ARM® processor composed of the Cortex®-A9 and 
Cortex®-M4 cores. 
The Cortex®-A9 core runs at a maximum of 1 GHz while the Cortex®-M4 core 
runs at a maximum of 200 MHz. The more powerful A9 core is available for user 
programs. The M4 core utilizes a RTOS and runs UEI-specific firmware.

2.5.2 FPGA The CPU module uses the Altera / Intel® MAX® 10 FPGA to communicate with 
the I/O boards via the 32-bit 66 MHz bus.

2.5.3 Memory and 
Storage

Table 2-8 lists the memory and storage hardware on the CPU/POWER module. 

NOTE: Memory and storage components are not user-accessible in PowerDNA 
mode, except when updating firmware.
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2.5.4 Ethernet Ports Two Ethernet ports are provided: 
• NIC1 provides communication between the PowerDNA SoloX RACK

system and the host PC/primary LAN network.

• NIC2 is designed as a diagnostic port for monitoring system health
during operation. It may be assigned as the primary Ethernet port if
NIC1 is not available for use.

Each port features a Physical Layer transceiver that supports 10BASE-Te, 
100BASE-TX and 1000BASE-T Ethernet protocols for implementation of 10/
100/1000 Mbps Ethernet LANs.

The Ethernet connection additionally supports precision clock synchronization 
and provides IEEE 1588 hardware time stamp support. Refer to the “PowerDNx 
1PPS Sync Interface Manual” for more information about synchronization 
support.

2.5.5 Real-time 
Clock

The real-time clock (RTC) is the hardware clock for the PowerDNA SoloX RACK 
system, which stores persistent date and time information. The RTC chip is the 
Dallis-Maxim DS1390 with a battery backup (Panasonic CR2032 coin).

2.5.6 RS-232 Ports 
(DIAG)

The 10-pin DIAG connector provides access to the A9 and M4 CPU cores 
through two separate RS-232 serial interfaces. Refer to Figure 4-16 for pinout. 
The serial interface can be used to program CPU parameters and read 
diagnostics. Serial connections run at: 57600 bps, 8 bits, no parity, 1 stop.

Table 2-8 Memory and Storage Components in PowerDNA SoloX Cube/Rack

Item Description

RAM (DDR3) 1 GB of SDRAM
(not user-accessible in PowerDNA mode)

eMMC Flash 8 GB flash
(not user-accessible in PowerDNA mode)

QSPI Boot Flash 16 MB of flash

Stores U-boot image, UEI environment variables, UEI initialization values, 
μC/OS firmware.

Solid State Hard Drive Optional internal SSDs installed on M.2 connector or 10-pin header
(UEIPAC only)

USB 2.0 Dual Ports External USB 1 and USB 2 ports connect to the CPU via a USB hub
(UEIPAC only)

µSD Card Optional micro Secure Digital card (up to 128 GB)
(UEIPAC only)
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Alternatively, you can communicate with the SoloX core module through the 
Ethernet port using UEI’s PowerDNA Explorer. PowerDNA Explorer is a GUI-
based application which can display diagnostic CPU module data, change the IP 
address, update firmware, and more. See Chapter 5 for more information about 
Explorer.

2.5.6.1 DIAG 
Accessories

The following UEI accessories are available for purchase: 
• DIAG to COM DB-9 connector cable to access the 

A9 core over a serial connection (CBL-SX6-DIAG). 

• CBL-SX6-SYNC cable and STP-SX6-DIAG board, which provide
access to both A9 and M4 serial interfaces. 

See Appendix A for more information about accessories. 

2.5.7 Sync Port The “Sync” port connection consists of 2 TTL input lines (CLK and TRIGGER) 
and 2 TTL output lines (CLK and TRIGGER), along with +5 V power and isolated 
ground. Refer to Figure 4-16 for pinout.
The Sync port is used for 1PPS synchronization, which synchronizes multiple 
systems to an external pulse-per-second reference signal. Two systems may be 
directly connected together, and larger groups may use UEI’s SYNC STP panel 
to share triggers and clocks among many chassis and systems. 

• Trigger and clock inputs accept TTL signals in (3.3 V to 5 V). The inputs
also have internal pull-up resistors to an internal 5 V supply, making the
inputs also compatible with a low-side drive open-collector outputs. 

• Trigger and clock outputs use 5 V logic levels. The sync connector’s
ground and 5 V power connections are provided by its own isolated 
DC-DC converter.

For more information, refer to the “PowerDNx 1PPS Sync Interface Manual,” 
which also describes IEEE-1588 PTP synchronization available through the 
Ethernet port.
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2.5.8 System Power 
Control & 
Monitoring

The DNR-POWER-1G board comprises an FPGA and other hardware to control 
and monitor system power, perform power conditioning, control diagnostic LED 
states, isolate and direct synchronization I/O to the CPU board, and control fan 
operation. The DNR-POWER-1G board is located at the bottom of the 
CPU/POWER core module shown in Figure 2-9. 
The POWER board uses a 24-bit ADC to monitor:

• Vin (9-36 VDC), Iin

• 24 V source, I24V

• 3.3 V source, I3.3V

• 2.5 V source (derived from 3.3V source)

• 1.5 V source, I1.5V

• 1.2 V source, I1.2V

• 8 V FAN source

• System temperature

NOTE: On RACK-based systems, Vin connects through a separate dedicated 
power module (DNR-POWER-DC, DNF-POWER-DC, or DNF-POWER-
AC). See Section 2.6 for more information.
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2.5.9 CPU/POWER 
Module Ports 
& LEDs

The PowerDNA SoloX RACK CPU/POWER module front panel is illustrated 
below in Figure 2-11 and described in Table 2-9. 

Figure 2-11  CPU/POWER Module Front Panel (Rack)

The Power In connector is on the DNx-POWER module located in slot 1 of the 
DNR-12-1G RACKtangle and DNR-6-1G HalfRACK or at the rear of the DNR-4-
1G FLATRACK.

Table 2-9 CPU/POWER Module Front Panel Descriptions (Rack)

No. Name Description Section

A DIAG 

Diagnostic port.
Provides serial comminication port to Cortex-A9 core 
and Cortex-M4 core. 
Serial connections run at 57600 bps, 8 bits, no parity, 1 stop 

Section 2.5.6

B nSIM card slot Optional slot for nano SIM card. Section 2.5.3

C USB 1, USB 2 USB 2.0 ports Section 2.5.3

D NIC1, NIC2 Ethernet ports: 1000/100/10Base-T connection.
RJ-45 connector for NIC1 (eth0) and NIC2 (eth1) Section 2.5.4

E µSD card slot Slot for optional µSD card up to 128 GB. Section 2.5.3

F Sync port High-speed, chassis-to-chassis connector for synchronizing 
multiple UEI systems. Section 2.5.7

G Reset Recessed reset button. n/a

H Status LEDs See Figure 2-12 and Table 2-10 for LED descriptions. n/a
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Figure 2-12  CPU/POWER Module LEDs (Rack)

For DNR-12-1G RACKtangle and DNR-6-1G HalfRACK systems only, additional 
LEDs are located on the DNR-POWER-DC module (refer to Section 2.6.2).

Table 2-10 CPU/POWER Module LED Descriptions (Rack)

No. Name Description

1 ATT Indicates system needs attention due to overrange condition: Error when red LED is ON

2 USR Optionally controlled by user application1: OFF is default

3 3.3 Indicates status of internal 3.3 V supply: LED ON (OK) / OFF (ERROR)

4 24 Indicates status of internal 24 V supply: LED ON (OK) / OFF (ERROR)

5 PG Indicates the presence of a valid power input: LED ON (OK) / OFF (ERROR)

6 COM Indicates I/O communication active: 
Flashes once/second when communicating / OFF when not

7 R/W Indicates bus activity: Flashes when bus is active / OFF when not

8 OverTemp Indicates high temperature condition in module: LED ON (high temp) / OFF when not

1.  For more information about how to read or set LEDs, please refer to DqAdvDnxpSetConfig() API 
described in the PowerDNA API Reference Manual and/or SampleDiagnostics.c sample code included 
with your SDK installation.
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2.6 DNR/DNF 
Power Module

In addition to the power hardware included in the DNx-CPU/POWER module, 
RACK-based systems include a separate power module:

• DNF-4-1G: The power module in a FLATRACK chassis is available in
AC or DC powered versions. The DC version requires a DC power
source between 9 and 36 Volts. The AC unit operates from 
100 to 240 VAC, from 50 to 60 Hz.
Power is connected via a Mini-Con-X connector at the rear of the FLA-
TRACK chassis. See Figure 4-16 for pinout.

• DNR-6-1G and DNR-12-1G: The power module in a RACKtangle and
HalfRACK chassis is the DNR-POWER-DC, which is always installed in
slot 1 of the chassis. 
Power is connected via a Molex connector on the DNR-POWER-DC.
Ports and LEDs on the DNR-POWER-DC module are shown in Figure
2-13 and described in Table 2-11.

2.6.1 Power 
Management 
Features

Features of the RACK power management system include:
• Input power — 9-36 VDC 80 W maximum, protected by resettable fuses

and EMI chokes

• Power supply on/off switch (with guard)

• Output power sources (all with greater than 90% efficiency)

• 24 V, 1 A (24 W)
• 3.3 V, 5 A (16.5 W, including the 2.5 V derived voltage)
• 2.5 V, 3 A (derived from 3.3 V source)
• 1.5 V, 5 A, (7.5 W, including the 1.2 V derived voltage)
• 8 V, 0.5 A (4 W for fans)

• DC/DC for 24 V, 3.3 V, and 1.5 V are synchronized from the single
spread- spectrum clock source in the CPU/NIC Core Module for low EMI
noise level

• Fan control (Forced ON) and status ON/OFF

• Monitoring and LED indicators (1% accuracy, 0.25Hz update rate) for

• All output voltages 
• Input current for the 9-36 VDC for the DNR enclosure
• All voltages from the NIC/Power Module (24 V, 3.3 V, 2.5 V)
• Temperature of the DNR backplane

• Provides 9-36 VDC for all modules from an external power source
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2.6.2 DNR Power 
Module Ports 
& LEDs

For DNR-12-1G and DNR-6-1G RACKtangle-based systems only, additional 
LEDs are installed on a DNR-POWER-DC module. 
The ports and LEDs of the DNR-POWER-DC module are illustrated in Figure 2-
13 and described in Table 2-11. 
For information about the ports and LEDs on the CPU module, refer to 

Figure 2-13  DNR-POWER-DC Front Panel (HalfRACK and 
RACKtangle only)

Table 2-11 DNR-POWER-DC Front Panel Descriptions (HalfRACK and RACKtangle only

No. Name Description

1 Vin LED Indicates status of input voltage: LED ON (OK) / OFF (ERROR)

2 1.5 LED Indicates status of 1.5 V onboard supply: LED ON (OK) / OFF (ERROR)

3 USR LED Optionally controlled by user application1: OFF is default

4 Temperature LED Indicates high temperature condition in module: LED ON (high temp) / OFF when 
not

5 24 LED Indicates status of 24 V onboard supply for I/O boards 1 - 6: 
LED ON (OK) / OFF (ERROR)

6 3.3 LED Indicates status of 3.3 V onboard supply for I/O boards 1 - 6: 
LED ON (OK) / OFF (ERROR)

7 Iin LED Indicates status of input current: LED ON (OK) / OFF (ERROR)

8 Fans LED Indicates state of fans: LED ON (ON) / OFF (OFF)

9 I/O LED Indicates I/O circuitry operation: LED flashes 1/second

10 ATTN LED Indicates system needs attention due to overrange condition: 
Error when red LED is ON 

11 24 LED Indicates status of 24 V onboard supply for I/O boards 7 - 12: 
LED ON (OK) / OFF (ERROR)
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1. For more information about how to read or set LEDs, please refer to DqAdvDnxpSetConfig() API described in 
the PowerDNA API Reference Manual and/or SampleDiagnostics.c sample code included with your SDK 
installation.

2.6.3 DC Power 
Thresholds

Table 2-12 lists the DC power threshold specifications for RACK systems.

1. Turn-on Voltage: The value of Vin at which the corresponding DC/DCs are turned on.

2. Reset Voltage: When Vin is below 7.2 V, a voltage reset puts all boards into reset mode.
3. Turn-off Voltage: The value of Vin at which the corresponding DC/DCs are turned off.

NOTE: The CPU/POWER module consumes 70 mW when Vin is below 7 V.

12 3.3 LED Indicates status of 3.3 V onboard supply for I/O boards 7 - 12: 
LED ON (OK) / OFF (ERROR)

13 Power Chassis ON / OFF switch. 

14 DC In DC In 4-pin molex connector: 9-36 VDC (DNA-PSU adapter included).
See Figure 4-16 for pinout.

Table 2-11 DNR-POWER-DC Front Panel Descriptions (HalfRACK and RACKtangle only

No. Name Description

Table 2-12 DC Power Thresholds for PowerDNA SoloX RACK

Backplane 
Power Rail 
Voltages

Turn-on 
Voltage, V1

Reset 
Voltage, V2

Turn-off 
Voltage, V3 Notes

Logic 
power supply

+3.3V, 
+2.5V, 
+1.5V, 
+1.2V

7.5 7.2 7.0 Supplies power to all 
CPUs and FPGAs

Analog 
power supply

+24V 8.5 - 7.8 Analog power supply 
is used as a 
regulated source for 
on-layer DC/DCs on 
most boards

Fan 
power supply

+12V 8.5 - 8.4

On-layer 
DC/DCs that use  

input power

+VIn 7.8-8.8 - 7.5-8.5 Varies with  I/O board 
type
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2.7 DNR-Buffer 
Module

The DNR-12-1G RACKtangle includes a DNR-BUFFER module, which buffers 
address/control/clock signals between the CPU and I/O board. The buffer board 
is not included or required for HalfRACK and FLATRACK systems.

Refer to Figure 2-1 on page 5 for location of buffer board in the RACKtangle 
chassis.

2.8 RACK I/O 
Boards

All standard UEI I/O boards are available for PowerDNA SoloX RACK systems. 
• Cube systems use a DNA- prefix, e.g. DNA-AI-207.

• RACKTangle and HalfRACK systems use a DNR- prefix, e.g. DNR-AI-
207.

• FLATRACK systems use a DNF- prefix, e.g. DNF-AI-207.

These boards are electronically identical. The only difference between DNA-, 
DNR-, and DNF- I/O boards is the physical mounting arrangement for 
installation in the different chassis types. 
I/O boards are populated into your chassis in the order you specify.

NOTE: Refer to the I/O board datasheets and user manuals for detailed 
electrical specifications, functional descriptions, pinouts, and 
programming instructions. These documents are available on the UEI 
website at www.ueidaq.com.
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Chapter 3 PowerDNA SoloX Cube System

This chapter provides the following information about PowerDNA SoloX Cube 
system hardware (DNA-PPCx-1G-11 and UEINet-11):

• SoloX Cube Overview (Section 3.1)

• Specifications (Section 3.2)

• Key Features (Section 3.3)

• Cube Enclosure (Section 3.4)

• CPU/POWER Module (Section 3.5)

• Cube I/O Boards (Section 3.6)

3.1 SoloX Cube 
Overview

The PowerDNA SoloX Cube is a Gigabit Ethernet-based data acquisition 
system housed in a Cube chassis.
PowerDNA SoloX Cube versions differ in the number of supported I/O boards:

• UEINet-11 accepts 1 user-selected I/O board

• DNA-PPC5-1G-11 accepts up to 3 user-selected I/O boards

• DNA-PPC8-1G-11 accepts up to 6 user-selected I/O boards

• DNA-PPC9-1G-11 accepts up to 7 user-selected I/O boards

Figure 3-1  DNA-PPC8-1G-11 and UEINet-11 Systems

NOTE: As an option for rackmount solutions, up to 4 Cube systems can be 
mounted in UEI’s DNA-19RACKW accessory assembly.

 SoloX CPU/Power Module

I/O Boards
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3.1.1 Cube System 
Components

A standard PowerDNA SoloX Cube system consists of the following modules:

As shown in Figure 3-1, the SoloX CPU/POWER 2-board module occupies the 
top portion of the Cube. It controls the unit’s operations, supervises the activity 
of the I/O boards, and manages system power. 
The remaining slots in the Cube are dedicated to user-selected I/O boards. To 
configure a complete data acquisition system, specify up to 7 DNA I/O boards 
for installation into your Cube enclosure. I/O boards may be specified in any 
combination of UEI’s DNA I/O boards.
For detailed descriptions of all I/O boards and accessories available for the 
PowerDNA SoloX Cube, refer to www.ueidaq.com.

Table 3-1 PowerDNA SoloX Cube Components

QTY Item Refer to Section

1 Cube enclosure Section 3.4

1 SoloX CPU/POWER module Section 3.5

up to 7 Your selection of DNR-series I/O boards Section 3.6

1 per unused 
slot

Blank filler panels for unused slots

1 DNA-PSU-24-100 100-Watt, 120/230 VAC to +24 VDC 
external power supply with cable and Molex connector
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3.2 Specifications Table 3-2 lists the technical specifications for the PowerDNA SoloX Cube:

1. Dimensions are given as lengthbase × widthbase × height.

2. Only user-accessible on UEIPAC stand-alone deployments
3. Shock and vibration specifications assume appropriate mounting/installation.

Table 3-2 PowerDNA SoloX Cube Specifications
Computer Interface
Primary Ethernet port 10/100/1000Base-T, RJ-45 connector
Diagnostic port 10/100/1000Base-T, RJ-45 connector
Config/Serial port Dual RS-232 ports, one per CPU core

Synchronization options

1. DNA-SYNC-1G series cables and boards provide 
both clock and trigger signals
2. DNA-IRIG-650 board for IRIG and GPS sync
3. IEEE-1588 sync

I/O Slots and Dimensions1

UEINet 1 slot (4.0” x 4.1” x 2.7”)
DNA-PPC5-1G 3 slots (4.0” x 4.1” x 4.0”)
DNA-PPC8-1G 6 slots (4.0” x 4.1” x 5.8”)
DNA-PPC9-1G 7 slots (4.0” x 4.1” x 6.6”)
Host Communications
Distance from host 100 meters max, CAT5+ cable
Ethernet data transfer rate 20 megabytes per second
Processor

CPU SoloX i.MX6 series dual core ARM processor
Cortex A9 core @ 1GHz, Cortex M4 @ 200 MHz

Memory 1 GByte RAM1

FLASH memory 8 GByte1

Solid-state hard drive not supported on PowerDNA deployments2

µSD card interface not supported on PowerDNA deployments2

USB port not supported on PowerDNA deployments2

Environmental
Electrical Isolation 350 Vrms
Temp (operating) -40 °C to +70 °C
Temp (storage) -40 °C to +85 °C
Humidity 0% to 95%, non-condensing

Vibration3  IEC 60068-2-6
                  IEC 60068-2-64

3 g, 10-500 Hz, sinusoidal 
3 g (rms), 10-500 Hz, broadband random

Shock3      IEC 60068-2-27
100 g, 3 ms half sine, 18 shocks @ 6 orientations
30 g, 11 ms half sine, 18 shocks @ 6 orientations

Altitude 70,000 feet, maximum
Power Requirements
Voltage 9-36 VDC (115/220 VAC adaptor included)
Power 7 Watts (not including I/O boards)
Reliability
MTBF >160,000 hours
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3.3 Key Features The following table is a list of key features of the PowerDNA SoloX Cube 
system.

Table 3-3 PowerDNA SoloX Cube Features

Easy to Configure and Deploy

• Over 80 different I/O boards available

• Built-in signal conditioning

• Flange kit for mounting to wall/flat surface

• DIN rail and Rack Mount kits

• Standard “Off-the-shelf” products and delivery

Flexible Connectivity

• Dual 1000Base-T Gigabit Ethernet ports with inde-
pendent IPs (100/10Base-T compatible)

• RS-232 interface

High Channel Density
A Cube with 7 I/O boards supports:

• Analog Inputs: up to 175 channels

• ICP/IEPE: up to 28 channels

• Analog Outputs: up to 224 channels

• Digital I/O: up to 336 channels

• ARINC-429: up to 112 channels

• Counter/Timer: up to 56 channels

• CAN-bus: up to 28 ports

• RVDT/LVDT: up to 28 channels

• RS-232/422/485: up to 56 ports

• Synchro/Resolver: up to 28 channels

• MIL-1553: up to 14 redundant ports

Compact Size

• 4.1” x 4” x 6.6” Cube holds 7 I/O boards

• 4.1” x 4” x 5.8” Cube holds 6 I/O boards

• 4.1” x 4” x 4.0” Cube holds 3 I/O boards

• 4.1” x 4” x 2.7” Cube holds 1 I/O board

True Real-time Performance

• 1 millisecond updates guaranteed with 1000 I/O

• Up to 6 million samples per second

• Use QNX, RTX, VxWorks

Outstanding Software Support

• Windows, Linux, RTX, VxWorks, and QNX operating
systems

• VB, VB.NET, C, C#, C++, Python

• MATLAB, LabVIEW, OPC, ActiveX support

Rugged and Industrial

• All Aluminum construction

• Operation tested from -40°C to 70°C

• Vibration tested to 3 g (operating)

• Shock tested to 100 g (operating)

• All I/O isolated from Cube and host PC

• Operation to 70,000 feet

• Fans included
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3.4 Cube 
Enclosure

The PowerDNA SoloX Cube enclosure is a rigid, extruded aluminum box with 
complete EMI shielding.The enclosure houses the following components:

• One DNA-CPU-1G-11 CPU/POWER module, which consists of:

• DNA-CPU-SX6 CPU board (slot 1) 
• DNA-POWER-1GB DC/DC power board (slot 2)

• DNA- I/O boards (slot 3 through up to slot 9, where the number of sup-
ported boards depends on the product version)

• DNA-IO-FILLER blank filler panels for unused slots

• Up to two 8-volt fans mounted on the rear cover of the cube

The CPU, Power, and I/O boards are stacked together and positioned on 
grooved guides behind the faceplate.
The Power module provides output voltages of 24, 3.3, 2.5, 1.5, and 1.2 VDC for 
the logic/CPU and 8 VDC to power the fans.

3.4.1 Fans & Air 
Flow

Figure 3-2 shows a representation of air flow through the PowerDNA cube.
Air is drawn into the rear of the enclosure, routed forward over the electronic 
circuit boards, up to the top of the enclosure, and then out the top rear of the 
enclosure. The system is designed to maintain positive pressure cooling within 
the enclosure at all times. 

Figure 3-2  Air Flow through a Cube Chassis

A temperature sensor mounted on the POWER board above the CPU monitors 
temperature within the cube. The system turns on the fan(s) if the temperature 
exceeds 45° C and shuts down power to the cube if a high limit is exceeded.
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Connector
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3.5 CPU/POWER 
Module

The core module on the PowerDNA SoloX Cube is a 2-board CPU/POWER 
module (DNA-CPU-1G-11):

• The CPU board is based on the NXP i.MX6 SoloX processor. It uses an
Altera/Intel FPGA to communicate with the I/O boards in the chassis.

• The POWER board is a dedicated DC/DC source and control system.

See Figure 2-9 on page 18 for a representative photo of the CPU/POWER core 
module. The core module on the Cube is the same as the core module on the 
Rack, except that power management on the Cube is handled exclusively by 
core module’s POWER board.
A block diagram of the CPU/POWER module is shown in Figure 2-10.

3.5.1 CPU 
Processor

Refer to Section 2.5.1. 

3.5.2 FPGA Refer to Section 2.5.2. 

3.5.3 Memory and 
Storage

Refer to Section 2.5.3. 

3.5.4 Ethernet Ports Refer to Section 2.5.4. 

3.5.5 Real-time 
Clock

Refer to Section 2.5.5. 

3.5.6 RS-232 Ports 
(DIAG)

Refer to Section 2.5.6. 

3.5.7 Sync Port Refer to Section 2.5.7. 
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3.5.8 Ports & LEDs The PowerDNA SoloX Cube CPU/POWER module front panel is illustrated 
below in Figure 3-3 and described in Table 3-4. 

Figure 3-3  CPU/POWER Module Front Panel (Cube)

Table 3-4 CPU/POWER Module Front Panel Descriptions (Cube)

No. Name Description Section

A DIAG 

Diagnostic port.
Provides serial comminication port to Cortex-A9 core 
and Cortex-M4 core. 
Serial connections run at 57600 bps, 8 bits, no parity, 1 stop 

Section 3.5.6

B USB 1, USB 2 USB 2.0 ports Section 3.5.3

C NIC1, NIC2 Ethernet ports: 1000/100/10Base-T connection.
RJ-45 connector for NIC1 (eth0) and NIC2 (eth1) Section 3.5.4

D Power In External power connects in through 4-pin Molex.
9-36VDC, DNA-PSU adapter included Section 3.5.9

E µSD card slot Slot for optional µSD card up to 128 GB. Section 3.5.3

F Reset Recessed reset button. n/a

G Sync port High-speed, chassis-to-chassis connector for synchronizing 
multiple UEI systems. Section 3.5.7

H nSIM card slot Optional slot for nano SIM card. Section 3.5.3

I Status LEDs See Figure 3-4 and Table 3-5 for LED descriptions. n/a
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Figure 3-4  CPU/POWER Module LEDs (Cube)

Table 3-5 CPU/POWER Module LED Descriptions (Cube)

No. Name Description

1 ATT Indicates system needs attention due to overrange condition: Error when red LED is ON

2 USR Optionally controlled by user application1: OFF is default

3 3.3 Indicates status of internal 3.3 V supply: LED ON (OK) / OFF (ERROR)

4 24 Indicates status of internal 24 V supply: LED ON (OK) / OFF (ERROR)

5 PG Indicates the presence of a valid power input: LED ON (OK) / OFF (ERROR)

6 COM Indicates I/O communication active: 
Flashes once/second when communicating / OFF when not

7 R/W Indicates bus activity: Flashes when bus is active / OFF when not

8 OverTemp Indicates high temperature condition in module: LED ON (high temp) / OFF when not
1.  For more information about how to read or set LEDs, please refer to DqAdvDnxpSetConfig() API 

described in the PowerDNA API Reference Manual and/or SampleDiagnostics.c sample code included 
with your SDK installation.
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3.5.9 System Power 
Control & 
Monitoring

All power management in a Cube chassis is provided by the DNA-POWER-1GB 
board. The DNR-POWER-1G board comprises an FPGA and other hardware to 
control and monitor system power, perform power conditioning, control 
diagnostic LED states, isolate and direct synchronization I/O to the CPU board, 
and control fan operation. The DNR-POWER-1G board is located at the bottom 
of the CPU/POWER core module shown in Figure 2-9.

3.5.9.1 Power 
Management 
Features

Features of the DNA-POWER-1GB board include:
• Input power — 9-36 VDC 80 W maximum, protected by resettable fuses

and EMI chokes

• Output power sources (all with greater than 90% efficiency)

• 24 V, 1 A (24 W)
• 3.3 V, 5 A (16.5 W, including the 2.5 V derived voltage)
• 2.5 V, 3 A (derived from 3.3 V source)
• 1.5 V, 5 A, (7.5 W, including the 1.2 V derived voltage)
• 8 V, 0.5 A (4 W for fans)

• DC/DC for 24 V, 3.3 V, and 1.5 V are synchronized from the single
spread- spectrum clock source in the CPU/NIC Core Module for low EMI
noise level

• Fan control (Forced ON) and status ON/OFF

• Monitoring with 24-bit ADC:

• Vin (9-36 VDC), Iin
• 24 V source, I24V

• 3.3 V source, I3.3V

• 2.5 V source (derived from 3.3V source)
• 1.5 V source, I1.5V

• 1.2 V source, I1.2V

• 8 V FAN source
• System temperature

• LED indicators (1% accuracy, 0.25Hz update rate) for status of Vin, 24 V
source, 3.3 V source, and temperature.

• Provides 9-36 VDC for all modules from an external power source
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3.5.9.2 DC Power 
Thresholds

Table 3-6 lists the DC power threshold specifications for Cube systems.

1. Turn-on Voltage: The value of Vin at which the corresponding DC/DCs are turned on.

2. Reset Voltage: When Vin is below 7.2 V, a voltage reset puts all boards into reset mode.
3. Turn-off Voltage: The value of Vin at which the corresponding DC/DCs are turned off.

NOTE: The CPU/POWER module consumes 70 mW when Vin is below 7 V.

3.6 Cube I/O 
Boards

All standard UEI I/O boards are available for PowerDNA SoloX Cube systems. 
• Cube systems use a DNA- prefix, e.g. DNA-AI-207.

• RACKTangle and HalfRACK systems use a DNR- prefix, e.g. DNR-AI-
207.

• FLATRACK systems use a DNF- prefix, e.g. DNF-AI-207.

These boards are electronically identical. The only difference between DNA-, 
DNR-, and DNF- I/O boards is the physical mounting arrangement for 
installation in the different chassis types. I/O boards are populated into your 
chassis in the order you specify.

NOTE: Refer to the I/O board datasheets and user manuals for detailed 
electrical specifications, functional descriptions, pinouts, and 
programming instructions. These documents are available on the UEI 
website at www.ueidaq.com.

Table 3-6 DC Power Thresholds for PowerDNA SoloX Cube

Backplane 
Power Rail 
Voltages

Turn-on 
Voltage, V1

Reset 
Voltage, V2

Turn-off 
Voltage, V3 Notes

Logic 
power supply

+3.3V, 
+2.5V, 
+1.5V, 
+1.2V

7.5 7.2 7.0 Supplies power to all 
CPUs and FPGAs

Analog 
power supply

+24V 8.5 - 7.8 Analog power supply 
is used as a 
regulated source for 
on-layer DC/DCs on 
most boards

Fan 
power supply

+12V 8.5 - 8.4

On-layer 
DC/DCs that use  

input power

+VIn 7.8-8.8 - 7.5-8.5 Varies with  I/O board 
type
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Chapter 4 Installation and Configuration

This chapter provides getting started instructions for working with your 
PowerDNA SoloX Cube/Rack. The following installation and configuration 
topics are included:

• Shipment Contents (Section 4.1)

• Installing Software (Section 4.2)

• Initial Bootup (Section 4.3)

• Updating IP Addresses (Section 4.4)

• Network Configuration (Section 4.5)

• Troubleshooting (Section 4.6)

• Updating Firmware (Section 4.7)

• Mounting & Field Connections (Section 4.8)

• Pinout Diagrams (Section 4.9)

• Wiring I/O Boards (Section 4.10)

• Repairing or Upgrading a Cube/RACK (Section 4.11)

• Disabling Writes to Flash/EEPROM (NVRAM) (Section 4.12)

4.1 Shipment 
Contents

The contents of the shipping package for a standard PowerDNA SoloX Cube/
Rack system include the following:

• A Cube or Rack enclosure.
Preinstalled with a CPU / POWER module, blank filler panels (if spec-
ified), plus your selection of I/O boards.

• RACK-based systems also include a DNR-POWER module
• DNR-12-1G systems also include a DNR-BUFFER module

• A DNA-PSU-XXX universal powerline brick and cable.

• Cat5e Ethernet cable, 7 ft.

• Removable USB media containing PowerDNA/DNR software

Figure 4-1  UEI Software USB Drive
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4.2 Installing 
Software

This section describes how to load the PowerDNA software suite onto a 
Windows- or Linux-based computer (i.e. host PC) and run some initial tests.

4.2.1 Installing 
Software on 
Windows

The PowerDNA USB provides one installer that combines the UEI low-level 
driver and UEIDAQ Framework.

Be sure to install third-party applications (such as LabVIEW, MATLAB, or Visual 
Studio) before installing the PowerDNA Software Suite. The installer 
automatically searches for third-party IDE and testing suites, and adds them as 
tools to the suites found. 

To install PowerDNA software, do the following:
STEP 1: Insert the provided UEI Software USB Drive (Figure 4-1) into your host PC. 

Alternatively, you may download the latest software suite from
www.ueidaq.com/downloads.
Launch the PowerDNA Software Suite installer as an administrator (Right-click 
setup.exe -> Run As Administrator).
The PowerDNA Welcome screen should appear:

Figure 4-2  PowerDNA Installer: Welcome Screen

STEP 2: Click Next > to continue the installation process. The End User License Agree-
ment window will open.

STEP 3: Read the license agreement, and click Next > to accept. The Choose Setup 
Type window will open.
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Figure 4-3  PowerDNA Installer: Choose Setup Type

You have three installation options:
• Typical installs the PowerDNA driver and core UEIDAQ Framework

components (C/C++ support and Session configuration utility) and any
required tools and plugins for detected software packages.

• Custom allows you to select which components will be installed. The
custom install dialog shows detected software packages (LabView,
MATLAB, etc.). 

• Complete installs the full PowerDNA Software Suite.

STEP 4: Unless you are an expert user and have specific requirements, select Typical 
and accept the default configuration.
If 32-bit Java is not detected on the system, Java JRE 6 will automatically be 
installed for the PowerDNA Explorer application. 

STEP 5: Click Install to proceed with the PowerDNA software installation and Finish to 
complete the installation.

NOTE: Because the installation process modifies your Windows registry, you 
should always install or uninstall the software using the appropriate 
utilities. Never remove PowerDNA software from your PC directly by 
deleting individual files; always use the Windows Control Panel 
Add/Remove Programs utility.

4.2.2 Installing 
Software on 
Linux

The PowerDNA_*.tgz file in the USB drive’s Linux folder contains the software 
package for Linux. To extract the file to a local directory:

Follow the instructions in the readme.txt file provided in the tar file.

tar -xjvf <Path to file>/PowerDNA_*.tgz
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4.3 Initial Bootup You can connect to the Cube/Rack via the Ethernet port or via the serial port. 
Before proceeding, verify that the network adapter on your host PC is configured 
to detect the Cube/Rack’s default IP address, 192.168.100.2 (see Appendix B).

4.3.1 Connecting to 
Cube/RACK 
via PowerDNA 
Explorer

PowerDNA Explorer is a GUI-based application which communicates with your 
Cube/RACK over an Ethernet connection. 
Refer to Chapter 5 for how to open, set up, and use PowerDNA Explorer.

4.3.2 Connecting to 
Cube/RACK 
via Serial Port

The following provides instructions for connecting over the serial port:

STEP 1: Attach the CBL-SX6-DIAG serial cable between the DIAG port on the Pow-
erDNA SoloX Cube/Rack and the serial port on your host PC (or to the USB-to-
serial adapter on your host PC). Refer to Figure 3-3 (Cube) or Figure 2-11 
(Rack) for the system’s front panel layout.

STEP 2: Open the serial port on your host PC:
a.) Run a serial terminal-emulation program on your host PC. For example,

• Windows host: MTTTY (installed with the PowerDNA software suite),
PuTTY, or any other terminal-emulation program except HyperTerminal.

• Linux host: minicom, kermit, or cu (part of uucp package).
b.) Select the COM port you are using and configure its settings to:
57600 baud, 8 bits, no parity, 1 stop bit
c.) Start the serial connection (e.g., by clicking Connect in MTTTY).

STEP 3: Connect power to the PowerDNA SoloX Cube/Rack:
Plug the 24 VDC power supply into the wall power outlet with the cable 
provided, and connect the 24 VDC 4-pin cable into the Power In connector on 
the Cube/Rack.

As soon as the system powers up, it runs through self-diagnostics and 
generates output text on the terminal program.
Once a connection is made, you will see a DQ> prompt. A typical readout is 
shown below.
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STEP 4: You can use the show command at the DQ> serial prompt to display additional 
information about the system configuration:

PowerDNA (C) UEI, 2001-2021. Running PowerDNA Firmware on SX6 SoloX
Built on 08:36:43 Oct  1 2021
RAM size:1GB  FLASH size:16MB
Initialize uC/OS-II (Real-Time Kernel v.29300)
ARM 101 ARM 255 ARM 261 ARM 20 ARM 40 ARM 11 SX6 MX6SX detected
5 devices detected

 Address   Irq  Model Option  Phy/Virt  S/N    Pri DevN
-------------------------------------------------------
0x54000000   2    101    1    phys   1269599     10   0
0x54010000   2    255    1    phys   1249193     20   1
0x54020000   2    261    1    phys   1278460     30   2
0x540C0000   2     20    1    phys   1223814     40   3
0x540D0000   3     40    1    phys   1234567     50   4
0x540E0000   3     11    B     cpu   0224359      0  14
-------------------------------------------------------
Current time: 10:38:01 09/09/2021
Power DNA version 5.1.0 release build 165
Built on 08:36:43 Oct  1 2021
996MHz i.MX6SoloX uC/OS v.29300 is running

Enter 'help' for help.

DQ> 
Two independent NICs
DQ>

DQ> show

        name: "IOM-224359"
       model: 4012
      serial: 0224359
      option: 000B
        fwct: 1.2.0.0
         mac: 00:0C:94:03:6C:67
         srv: 192.168.100.1
          ip: 192.168.100.2 (DOWN)
     gateway: 192.168.100.1
     netmask: 255.255.255.0
        mac2: 00:0C:94:F3:6C:67
        srv2: 192.168.101.1
         ip2: 192.168.101.2 (DOWN)
    gateway2: 192.168.101.1
    netmask2: 255.255.255.0
         udp: 6334
     license: ""
    Manufactured 10/1/2020
    Calibrated 10/15/2020

DQ> 
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Through the serial connection, all parameters can be changed, including the IP 
address, gateway, and subnet mask (netmask) system configuration. 
The next section provides instructions for changing the IP address. Chapter 6: 
"Programming CPU Parameters" provides information about changing other 
parameters via the serial port.

4.4 Updating IP 
Addresses

The PowerDNA SoloX Cube/Rack ships with pre-configured factory default IP 
addresses for NIC1 and NIC2 in nonvolatile memory (usually 192.168.100.2 for 
NIC1 and 192.168.100.102 for NIC2). These are static IP addresses; a hosted 
Cube/Rack system never retrieves its IP address from a DHCP server. 
Most users use the default addresses without issue. However, if you require a 
different IP address, you can change it by using PowerDNA Explorer or by using 
the serial port.

4.4.1 When Should 
You Change 
the IP 
Address?

You should change your IP address if you have multiple UEI chassis in your 
application or if your application has network addressing guidelines you must 
conform to.
Before connecting your PowerDNA SoloX Cube/Rack to a general-purpose 
(company domain) network, consider the following: 

• High sampling rate measurements consume a lot of the available band-
width.

• Some samples may be significantly delayed or entirely dropped (lost)
due to network congestion, collisions or a slow switch.

• Whether a system will be accessed by multiple parties on a LAN.

• Whether multiple Cube/Rack systems will operate (and interact) on the
same network.

Alternatively, if you plan to use the system for high-speed measurements where 
high reliability is necessary, a direct connection between the host PC and the 
Cube/Rack is recommended. 
Refer to “Network Configuration” on page 46 for more information.

4.4.2 Updating IP 
Address via 
PowerDNA 
Explorer

PowerDNA Explorer is a GUI-based application which communicates with your 
Cube/RACK over an Ethernet connection.

NOTE: You can only change the NIC1 address using Explorer. To change the 
NIC2 address, see “Updating IP Address via Serial Port” on page 45.

STEP 1: Connect power to the PowerDNA SoloX Cube/Rack.
Plug the 24 VDC power supply into the wall power outlet with the cable provided, 
and connect the 24 VDC 4-pin cable into the Power In connector on the Cube/
Rack.

STEP 2: Connect an Ethernet cable between your PC Ethernet port and the NIC 1 port on 
the Cube (NIC 2 is reserved for Diagnostics).
Verify that the two LEDs on the NIC 1 Ethernet port on the Cube are lit or 
flashing. (NIC cards limited to 10baseT only have the left LED flashing.) If the 
LEDs do not light, you may be using a “crossover” cable. Try a “straight-through” 
cable instead.

STEP 3: Launch PowerDNA Explorer.
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• On Windows, access Explorer from the Start menu: 
Start » All Programs » UEI » PowerDNA » PowerDNA Explorer

• On Linux, access PowerDNA Explorer under the UEI installation direc-
tory (<PowerDNA-x.y.z>/explorer) by typing:
   java -jar PowerDNAExplorer.jar

STEP 4: In the PowerDNA Explorer toolbar, click Scan Network (see Figure 4-4). A 
device name, IOM-#### (where #### is the Cube/Rack serial number), will 
appear.

STEP 5: In the left panel, click the Cube/Rack device that you want to update (e.g., IOM-
####). The right panel will show the IP Addresses and other configuration infor-
mation of your Cube/Rack.

STEP 6: Type the new IP Address in the IP 1 field and press Enter on your keyboard. 
STEP 7: Click the Store Configuration icon to make the changes persistent. If asked for 

a password, the default is powerdna.
STEP 8: Click Network » Reset IOM... in the PowerDNA Explorer menu to make 

changes take effect.
The new IP Address will be stored in non-volatile memory and display in 
PowerDNA Explorer.

Figure 4-4.  Using PowerDNA Explorer to Change IP Address

If needed, the gateway and network mask can be changed via the serial port. 
Refer to Section 6.3.3 on page 80 for instructions. 

4.4.3 Updating IP 
Address via 
Serial Port

You can update NIC1 and/or NIC2 addresses on the Cube/Rack over a serial 
connection.

STEP 1: Remove power and Ethernet connections from the Cube/Rack.
STEP 2: Attach the CBL-SX6-DIAG serial cable between the DIAG port on the Pow-

erDNA SoloX Cube/Rack and the serial port on your host PC (or to the USB-to-
serial adapter on your host PC). Refer to Figure 3-3 (Cube) or Figure 2-11 
(Rack) for the system’s front panel layout.

Scan Network

Enter new
IP Address

Store Configuration
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STEP 3: Open the serial port on your host PC:
a.) Run a serial terminal-emulation program on your host PC. For example,

• Windows host: MTTTY (installed with the PowerDNA software suite),
PuTTY, or any other terminal-emulation program except HyperTerminal.

• Linux host: minicom, kermit, or cu (part of uucp package).
b.) Select the COM port you are using and configure its settings to:
57600 baud, 8 bits, no parity, 1 stop bit
c.) Start the serial connection (e.g., by clicking Connect in MTTTY).

STEP 4: Connect power to the PowerDNA SoloX Cube/Rack:
Plug the 24 VDC power supply into the wall power outlet with the cable provided, 
and connect the 24 VDC 4-pin cable into the Power In connector on the Cube/
Rack.
Once a connection is made, you will see a DQ> prompt.

STEP 5: To change the NIC1 address, type set ip <new IP address> in the MTTTY 
window at the DQ> prompt (Figure 4-5). When prompted for a password, type 
powerdna.
To change the NIC2 address, type: set ip2 <new IP address>

Figure 4-5  Updating Primary IP Address in MTTTY

STEP 6: Type store to make the changes persistent. 
STEP 7: Type reset to make changes take effect. 
STEP 8: Type show to verify updated network settings.

4.5 Network 
Configuration

If you do not need to connect to a company LAN and have only a single 
Cube/Rack in your system, you can connect it directly to your host as shown in 
Figure 4-6 below. The PowerDNA SoloX Cube/Rack provides two NIC ports, but 
only one can be used for I/O operations at a time. You can use the other port to 
read diagnostics or serve as a backup in case the primary port fails. 
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Figure 4-6  Single Cube/Rack Direct-Connected to Host without LAN 
Switch

When connecting to a network, to improve Cube/Rack network performance, we 
recommend that instead of connecting to a company-wide network, you use 
separate commercially available network interface controller (NIC) cards and, 
where possible, set up a single dedicated mini-network for cubes for both 
operation and diagnostics, as shown in Figure 4-7 below.
Figure 4-7 shows a two-cube single network system with a LAN switch that 
performs both data acquisition and diagnostic functions.

Figure 4-7  Single Network for Operation and Diagnostics Using 
Cubes and One LAN Switch

As an alternative, you can configure two separate networks, one for operation 
and one for diagnostic purposes, as shown in Figure 4-8. 

NIC1 - 192.168.1.10 

                                     Port)

NIC2 
192.168.100.3 

(Diagnostic Port 

                   (Primary Port)

if needed)

NIC1 - 192.168.1.10

NIC2 - 192.168.100.3 
(Diagnostics)
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Figure 4-8 shows a two-cube dual network system that performs both data 
acquisition and diagnostic functions and uses two LAN switches for routing.

Figure 4-8  Separate Networks for Operation and Diagnostics: 
Two Cubes & Two Switches

4.5.1 Example of 
Configuring 
Network 
Settings

This section provides an example of configuring a separate network for 
diagnostics.
In this example, we assume that your office uses a Class C network (the class 
intended for small networks with fewer than 256 devices), and your host PC is 
configured with a static IP or via DHCH (Dynamic Host Configuration Protocol).

STEP 1: Obtain the networking configuration of your host PC:
• On Windows systems, open the command prompt and type ipconfig

to display the configuration:
Start >> Programs >> Windows System >> Command Prompt

• On Linux systems, type ifconfig at the Linux prompt.

In the above example, the subnet mask of 255.255.255.0 uses the 
subnet range 192.168.1.0 through 192.168.1.255. Refer to the 
IP Addressing Side Note on the next page for more information about subnets.

    NIC1 - to Intranet 

NIC2 - 
to diagnostic ports 

C:\> ipconfig
Ethernet adapter Local Area Connection:
      Connection-specific DNS Suffix  . :
      IPv4 Address. . . . . . . . . . . : 192.168.1.10
      Subnet Mask . . . . . . . . . . . : 255.255.255.0
      Default Gateway . . . . . . . . . : 192.168.1.1
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STEP 2: Install a secondary NIC card in your host PC, if needed.
STEP 3: Set up a secondary network that does not overlap the existing one:

In our example, the address space 192.168.1.0-192.168.1.255 is used by NIC1. 
The IP address block 192.168.100.1 to 192.168.100.255 is available and is in 
the private range.
We will choose 192.168.100.1-192.168.100.255 for the PC’s secondary NIC and 
setup the port as follows:

IPv4 Address: 192.168.100.3
Subnet mask: 255.255.255.0
Default Gateway:192.168.100.3

a. On your host PC, open the Network and Internet settings in the control 
panel:

     Start >> Programs >> Control Panel >> Network and Internet >> View network status and tasks
b.   Click Change adapter settings in the left-sidebar, and then right-click the 

adapter to bring up the Properties window.

c.   Open the TCP/IPv4 properties of the adapter and edit to the network 
settings noted above.

NOTE: Refer to Appendix B for step-by-step instructions and screenshots on 
how to set up TCP/IPv4 properties.

IP Addressing Side Note:
The range of usable addresses is defined by the IP address and subnet mask. 

• An IP address is a number that lies within the range of 0.0.0.0 and 255.255.255.255. 
In the ipconfig example shown in step 1, the IP address is 192.168.1.10.

• The subnet mask indicates where an address range starts and stops. For example, a subnet mask 
255.255.255.240 has 15 usable addresses (255.255.255.255 – 255.255.255.240). In the 
ipconfig example shown in step 1, the subnet is 255.255.255.0, or 255 addresses.

The subnet limits from anything.anything.anything.0 up to the max.
• The usable range for 192.168.1.10/255.255.255.0 is 192.168.1.1 to 192.168.1.254 (192.168.1.0 

and 192.168.1.255 are reserved for Router and Broadcast messages).
• The usable range for 192.168.100.2/255.255.255.0 is 192.168.100.1 to 192.168.100.254

Not every IP address from 0.0.0.0 to 255.255.255.255 is usable; however, these three ranges of IP 
addresses are guaranteed open for private use:

• 10.0.0.0 – 10.255.255.255
• 172.16.0.0 – 172.31.255.255
• 192.168.0.0 – 192.168.255.255
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d.   Open the Command Prompt:

Start >> Programs >> Windows System >> Command Prompt

e.   Type ipconfig at the command prompt to confirm the network 
configuration on the host PC (unused adapter settings are not shown in 
this example).

STEP 4: Use a serial terminal application (e.g. MTTTY) on the host to configure the 
Cube/Rack system to use the same subnet as the host PC. We’ll set up the 
diagnostic port of the cube with the following:

Cube NIC2 IP: 192.168.100.2 
Cube NIC2 Gateway:192.168.100.3
Cube NIC2 Netmask: 255.255.255.0

a. Attach a serial cable between the host PC and the RS-232 port on the 
front panel of the Cube/Rack.

b.   Run a serial terminal-emulation program: MTTTY (installed with the 
PowerDNA software suite), PuTTY, or any other terminal-emulation 
program except HyperTermina

c.   Verify that COM parameters are set at 57600 baud, 8 bits, no parity, 
1 stop bit.

d.   Click Connect in MTTTY, or use the commands on one of the other 
terminal-emulation programs to establish communication with the 
Cube/Rack system.

e.   Enter the following commands when you see the DQ command prompt:

NOTE: The Cube/Rack NIC2 IP address in this example is changed to 
192.168.100.2 in step 4 above (in the same subnet as your host PC’s 
NIC2 at 192.168.100.3 which was set up in step 3). This example 
assumes NIC1 is already configured on your Cube/Rack system.

C:\> ipconfig
Ethernet adapter Local Area Connection:
        Connection-specific DNS Suffix  . :
        IPv4 Address. . . . . . . . . . . : 192.168.1.10
        Subnet Mask . . . . . . . . . . . : 255.255.255.0
        Default Gateway . . . . . . .. . .: 192.168.1.1

Ethernet adapter Local Area Connection 2:
        Connection-specific DNS Suffix  . :
        IPv4 Address. . . . . . . . . . . : 192.168.100.3
        Subnet Mask . . . . . . . . . . . : 255.255.255.0
        Default Gateway . . . . . . . . . : 192.168.100.3

DQ> set ip2 192.168.100.2 
DQ> set gateway2 192.168.100.3 
DQ> set netmask2 255.255.255.0 
DQ> store
DQ> reset
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STEP 5: Connect the Cube/Rack to your PC’s second NIC using a CAT5 cable. The 
green LEDs on the Cube/Rack NIC2 should light up.

STEP 6: Ping the Cube/Rack system from the command prompt on the host PC to make 
sure that it is alive (the following shows a successful response):

NOTE: A “Request Timed Out” message indicates an error.

The system should now be configured as shown below.

Figure 4-9  Typical Configuration for a Single Cube/Rack with a LAN 
Switch

You may now use PowerDNA Explorer to view system network settings and 
communicate with your cube. (Refer to Chapter 5: "PowerDNA Explorer" for 
more information about PowerDNA Explorer, if needed.)

4.6 Trouble-
shooting

The following sections provide suggestions when troubleshooting your system.

4.6.1 Trouble-
shooting 
System 
Communicatio
n

Use following checklist as a starting point.

 Verify the PG (Power Good) LED is ON: 
This indicates power is applied to the chassis. Refer to Figure 3-4 (Cube) 
or Figure 2-12 (Rack) for LED locations.

 Verify the green LEDs on NIC ports are blinking: 
This indicates the CAT5e cables are connected.

 Check communication over the Ethernet connection: 
Use the command prompt to ping the Cube/Rack IP” 
ping 192.168.100.2
If ping doesn’t respond, check the following

•  Disable the firewall (temporarily) on the NIC.

C:\> ping –n 1 192.168.100.2
Pinging 192.168.100.2 with 32 bytes of data:

Reply from 192.168.100.2: bytes=32 time<1ms TTL=128
Ping statistics for 192.168.100.2:
Packets: Sent = 1, Received = 1, Lost = 0 (0% loss),

NIC1 - 192.168.1.10

NIC2 - 192.168.100.3 
(Diagnostic Port)

Primary
Port

Diagnostic
Port
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•  Check the NIC’s network settings.
•  Check the system’s network settings.

 Check communication over the serial connection:
Connect a serial cable between your host PC and your Cube/Rack 
chassis, open a serial communication program (e.g., MTTTY), and click 
Connect:

•  Press [Enter] in the serial terminal window to display the DQ> prompt.
   (No prompt indicates that you are not connected).

•   If you cannot connect over the serial port, check the following:
•  Verify the settings: 57600 baud, no parity, 8 data bits, 1 stop bit.
•  Check the device manager on your PC to see which com port you 

are using. Enter that com port in your serial communications 
program, (e.g., COM1, COM2, COM3), click Connect and press 
<Enter>.

•  If you are able to connect over the serial port, check the following:
•  Type “show” the serial terminal window to verify the IP, Subnet 

Mask, and Gateway.
•  Note “show” results, and verify computers are on a valid subnet 

and have valid IPs. 
•  Reboot the Cube/Rack system. The start-up screen should display 

upon restart.

 If you have questions, contact UEI support at support@ueidaq.com.

4.6.2 Trouble-
shooting 
Communicatio
n after Reset

After your Cube/Rack is set up and you reset the chassis, you may notice a 
situation where you can’t see your Cube/Rack from a host computer 
immediately after reset. After up to two minutes, the connection shows up again.
This is caused by the operating system Address Resolution Protocol (ARP) 
implementation. When you try to contact an offline host that was previously 
online, the OS invalidates the Ethernet <-> IP address resolution protocol table 
until a timeout expires and it can be re-queried.

4.6.2.1 How to Find 
ARP Timeout 
Setting

To find how long the refresh timeout is on Windows machines, do the following:

STEP 1: Open a command window on your host computer.
STEP 2: Type netsh interface ipv4 show interfaces at the command prompt 

to find the index number of the interface connected to your cube, (e.g., 11 for the 
Local Area Connection):
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Figure 4-10  Show Interfaces

STEP 3: Type netsh interface ipv4 show interface <Idx #> to learn the 
timeout and other interface parameters of a connection:

Figure 4-11  Show Interface Parameters

NOTE: In the above example, the timeout, or Base Reachable Time, is set to 
30000 ms.

4.6.2.2 How to Speed 
Up ARP 
Timeout

To avoid waiting for the timeout, you can either force an immediate rebuild of the 
ARP cache or change the delay for subsequent timeout situations. 
Both of the following must be entered as an administrator.

• To immediately reset, type the following at the command prompt: 
arp –d *

• To modify the Base Reachable Time, type the following to set the tim-
eout to 5000 ms on interface 11:

netsh interface ipv4 set interface 11 basereachable=5000
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4.7 Updating 
Firmware

This section provides instructions for updating firmware on a PowerDNA SoloX 
Cube/Rack. The CPU/POWER module stores the system firmware.

• Locating Firmware (Section 4.7.1)

• Determining Current Firmware Version (Section 4.7.2)

• Updating Firmware via PowerDNA Explorer (Section 4.7.3)

• Updating Firmware via USB and Serial (Section 4.7.4)

4.7.1 Locating 
Firmware

UEI periodically releases updated firmware to introduce new features and to 
improve the performance of existing features. Updated firmware releases are 
bundled with the full PowerDNA Software Suite, available for download at any 
time from www.ueidaq.com.
To locate the latest UEI firmware after installing the PowerDNA Software Suite, 
browse to the installation’s Firmware directory, e.g. 
C:\Program Files (x86)\UEI\PowerDNA\Firmware

The SoloX firmware is a .bin file located in the Firmware_ARM_SOLOX 
subdirectory. 

4.7.2 Determining 
Current 
Firmware 
Version

To check the version of your firmware, you can use PowerDNA Explorer, a GUI-
based application for communicating with your PowerDNA SoloX Cube/Rack 
system.

STEP 1: Connect power to the PowerDNA SoloX Cube/Rack:
Plug the 24 VDC power supply into the wall power outlet with the cable 
provided, and connect the 24 VDC 4-pin cable into the Power In connector on 
the Cube/Rack.

STEP 2: Connect an Ethernet cable between the NIC 1 port on the Cube/Rack and the 
host PC or network (e.g., host PC Ethernet port, switch).

STEP 3: Start PowerDNA Explorer:
• From the Windows desktop menu, navigate to:

Start » Programs » UEI » PowerDNA » PowerDNA Explorer

• On Linux systems, access PowerDNA Explorer under the UEI installa-
tion directory (<PowerDNA-x.y.z>/explorer) and type:
java -jar PowerDNAExplorer.jar

STEP 4: In the PowerDNA Explorer window, click Network » Scan Network.
STEP 5: Click the icon of the PowerDNA SoloX Cube/Rack you wish to query.
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STEP 6: Note the version that is given in the FW Ver field (Figure 4-12).

Figure 4-12  Displaying the Version of Your Firmware

If the FW Ver has a yellow triangle with an exclamation point next to it (see 
figure above), you have a mismatch between the firmware installed on your 
UEI chassis and the software version on your host PC. If you see this 
warning, UEI highly recommends that you update your firmware to match 
your software (or software to match your firmware). Firmware version 
mismatches can result in unexpected operation.

NOTE: The SoloX CPU supports FW Ver 5.0.0.20 and up.

4.7.3 Updating 
Firmware via 
PowerDNA 
Explorer

To update firmware with the PowerDNA Explorer application over Ethernet:

STEP 1: Connect power to the PowerDNA SoloX Cube/Rack:
Plug the 24 VDC power supply into the wall power outlet with the cable 
provided, and connect the 24 VDC 4-pin cable into the Power In connector on 
the Cube/Rack.

STEP 2: Connect an Ethernet cable between the NIC 1 port on the Cube/Rack and the 
host PC or network (e.g., host PC Ethernet port, switch).

STEP 3: Start PowerDNA Explorer:
• From the Windows desktop menu, navigate to:

Start » Programs » UEI » PowerDNA » PowerDNA Explorer

• On Linux systems, access PowerDNA Explorer under the UEI installa-
tion directory (<PowerDNA-x.y.z>/explorer) and type:
java -jar PowerDNAExplorer.jar

Be sure to use PowerDNA Explorer from the same release version as the
new firmware.
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STEP 4: In the PowerDNA Explorer window, click Network » Scan Network.
STEP 5: Click the icon of the PowerDNA SoloX Cube/Rack you wish to update.
STEP 6: Click  Network » Update Firmware... from the menu.

Figure 4-13  Update Firmware Menu Item

STEP 7: Click “Yes” when you see the prompt:
“Are you sure you want to update firmware…”

STEP 8: Verify you are in the Firmware_ARM_SOLOX directory, and double-click the 
rom_arm_solox_X.X.X.bin file (where X.X.X. is the version).

STEP 9: If asked, enter the password to continue. All UEI Cube and Rack systems come 
with the default password set to powerdna.

Figure 4-14  Password Dialog Box

STEP 10: Wait for the progress dialog to complete. The system will then be updated and 
running the new firmware.

Figure 4-15  Firmware Update Progress Dialog Box

 

powerdna 
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4.7.4 Updating 
Firmware via 
USB and 
Serial

Before you begin, you will need a removable USB drive (any size). 

NOTE: The instructions below are for a Windows-formatted USB drive. Use of 
a Linux formatted drive is permitted; just substitute fatls with ext4ls 
in Step 8 and fatload with ext4load in Step 9.

STEP 1: Copy the firmware image file to the removable USB drive.
The file is located in your UEI installation directory, e.g.

\Program Files (x86)\UEI\PowerDNA\Firmware\Firmware_ARM_SOLOX\rom_arm_solox_x.y.z.bin

STEP 2: Plug the removable USB drive into the PowerDNA SoloX Cube/Rack.
STEP 3: Attach the UEI-provided serial cable between the DIAG port on the PowerDNA 

SoloX Cube/Rack and the serial port on your host PC (or to the USB-to-serial 
adapter on your host PC).

a.) Install and run a serial terminal-emulation program on your host PC. For 
example,

• Windows host: MTTTY provided with the PowerDNA software suite),
PuTTY, or any other terminal-emulation program except HyperTerminal.

• Linux host: minicom, kermit, or cu (part of uucp package).
b.) Select the COM port you are using and configure its settings to:
57600 baud, 8 bits, no parity, 1 stop bit
c.) Start the serial connection (e.g., by clicking Connect in MTTTY).

STEP 4: Connect power to the PowerDNA SoloX Cube/Rack:
Plug the 24 VDC power supply into the wall power outlet with the cable 
provided, and connect the 24 VDC 4-pin cable into the Power In connector on 
the Cube/Rack.

As soon as the Cube/Rack starts booting up, it runs through self-diagnostics 
and generates output text on the terminal program.
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STEP 5: When you see the “Enter password - autoboot in 5 seconds...” 
prompt, enter powerdna (the password will not print to the screen as you are 
typing). When you successfully enter U-Boot space, the prompt becomes a =>.

If your device has already autobooted, you can type reset at the DQ> prompt to 
restart booting.

NOTE: Older versions of U-Boot do not ask for a password. Instead, you will 
see a “Hit any key to stop autoboot” prompt. To enter U-Boot 
space, continuously press the Enter key before the autoboot occurs. 

STEP 6: Reset the USB:

U-Boot 2019.04-imx_v2019.84_4.19.35_1.1.0-uei+g4d377539a1 (Jun 26 2021 - 
05:00:13 +0000)
CPU: Freescale i.MX6SX rev1.3 996 MHz (running at 792 MHz)
CPU: Extended Commercial temperature grade (-20C to 105C) at 320
Reset cause: POR
Model: UEI PDNX-CPU-SX6 Board
Board: UEI SOLOX
DRAM: 1 GiB
MMC: FSL_SDHC: 1, FSL_SDHC: 2
Loading Environment from SPI Flash... SF: Detected w25q128 with page size 
256 Bytes, erase size 4 KiB, total 16 MiB
OK
Display: PDNASX6HDMI (1366x768)
Video: 1366x768x24
In: serial
Out: vga
Err: vga
USBO: USB EHCI 1.00
USB1: USB EHCI 1.00
scanning bus e for devices... 1 USB Device(s) found
scanning bus 1 for devices... 2 USB Device(s) found
scanning usb for storage devices... Storage Device(s) found
Net: CPU Net Initialization Failed
No ethernet found.
Enter password - autoboot in 5 seconds...
=>

=> usb reset
resetting USB...
USB0:   USB EHCI 1.00
scanning bus 0 for devices... 2 USB Device(s) found
USB1:   USB EHCI 1.00
scanning bus 1 for devices... 3 USB Device(s) found
       scanning usb for storage devices... 2 Storage Device(s) found
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STEP 7: Determine the “Device #” and “Partition #” of the removable USB:

In the example shown above, the Device # is 1.
Windows-formatted USB drives typically contain only one partition; therefore, 
Partition # should be 1.

STEP 8: Verify the location of the firmware image by typing 
fatls usb <device#>:<partition#>

where <device#> and <partition#> are replaced with the values from 
Step 7. For example:

STEP 9: Upload firmware image from the USB:

STEP 10: Set the U-boot variables ucos_bin_addr and ucos_bin_size:

STEP 11: Probe QSPI flash:

The following step erases blocks in QSPI flash. Use care when entering 
the erase range so that you don’t accidentally erase other system 
components.

=> usb storage
  Device 0: Vendor: Virtium  Rev: 0428 Prod: TuffDrive       
            Type: Hard Disk
            Capacity: 7632.1 MB = 7.4 GB (15630680 x 512)
  Device 1: Vendor: SanDisk  Rev: 1.26 Prod: Cruzer Glide    
            Type: Removable Hard Disk
            Capacity: 15267.0 MB = 14.9 GB (31266816 x 512)

=> fatls usb 1:1
            system volume information/
  2896592   rom_arm_solox_5_1_0_165.bin 

1 file(s), 1 dir(s)

=> fatload usb 1:1 $loadaddr rom_arm_solox_5_1_0_165.bin
reading rom_arm_solox_5_1_0_165.bin
2896592 bytes read in 249 ms (11.1 MiB/s)

=> setenv ucos_bin_addr 0x200000
=> setenv ucos_bin_size $filesize
=> saveenv

=> sf probe
SF: Detected w25q128bv with page size 256 Bytes, erase size 4 KiB, total 
16 MiB
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STEP 12: Erase the old firmware image from QSPI flash. The firmware image partition 
starts at address offset 0x200000 and has size 0x800000. This command may 
take a minute or so to execute. 

STEP 13: Write the new firmware image to QSPI flash:

STEP 14: The firmware is now updated and you can eject the USB drive.
STEP 15: To run the new firmware, type run ucosboot in the serial terminal window (or 

reboot the Cube/Rack).

=> sf erase 0x200000 0x800000
SF: 8388608 bytes @ 0x200000 Erased: OK

=> sf write $loadaddr $ucos_bin_addr $ucos_bin_size
device 0 offset 0x200000, size 0x2c32d0
SF: 2896592 bytes @ 0x200000 Written: OK
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4.8 Mounting & 
Field 
Connections

This section provides mounting and field connection descriptions for each of the 
Cube/Rack chassis types:
DNA-PPCx-1G
The DNA-PPCx-1G (Cube) mounting options include the following: 

• For horizontal surface mounting, use a flange accessory and secure the
case directly to the surface. 

• For mounting on a vertical wall surface, use a 19RACKW accessory
with DIN rail and attach the assembly to a standard 19-inch rack with
screws.

DNR-12-1G
The DNR-12-1G (RACKtangle) mounting options include the following. 

• For horizontal surface mounting, use the rubber feet supplied with the
standard enclosure or bolt the case directly to the surface. 

• For mounting on a vertical wall surface, attach flanges to both ends of
the enclosure with the flanges aligned flush with the rear of the enclo-
sure; then fasten the flanges to the surface with screws or bolts. 

• For mounting in a standard 19-inch rack, attach flanges to both ends of
the enclosure with the flanges aligned flush with the front of the enclo-
sure. Then attach the flanges to the rack with bolts. 

Note that the flanges are included with the purchase of a PowerDNA SoloX 
Rack. If you need more clearance from the rack front panel, refer to the DNR-
EXT-BRACKET-4 which provides 3.625 inches of clearance.

DNR-6-1G
The DNR-6-1G (HalfRACK) mounting options include the following: 

• For horizontal surface mounting, use the rubber feet supplied with the
standard enclosure or bolt the case directly to the surface. 

• For mounting on a vertical wall surface, attach flanges to both ends of
the enclosure with the flanges aligned flush with the rear of the enclo-
sure; then fasten the flanges to the surface with screws or bolts. 

• For mounting in a standard 19-inch rack, since the DNR-6-1G is not 19”
wide, UEI recommends using a shelf for rack installations. 

DNF-4-1G
The DNF-4-1G (FLATRACK) can be mounted in a standard 19-inch rack using 
the included rack mount brackets or on a horizontal surface using the base 
mount brackets. 

• For mounting in a standard 19-inch rack, attach flanges to both ends of
the enclosure with the flanges aligned flush with the front of the enclo-
sure. Then attach the flanges to the rack with bolts. 

If you need technical drawings, please contact UEI support at 
support@ueidaq.com.
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4.8.1 Physical 
Dimensions

The housing used in each of the UEIPAC chassis types is as follows: 
• DNA-PPCx-1G Cube consists of an extruded aluminum box with slotted

guides plus a faceplate and rear cover. 

• DNR-4-1G (FLATRACK) is compatible with Specification EIA-310-C for
19” Rack Mounting Equipment and is designed to occupy 1U unit of ver-
tical space (where 1U is 1.75”).

• DNR-12-1G and DNR-6-1G (RACKtangle and HalfRACK) systems are
also compatible with Specification EIA-310-C for 19” Rack Mounting
Equipment and is designed to occupy 3U units of vertical space.

The physical dimensions of Cube/Rack versions are listed below:

1. Dimensions are given as lengthbase × widthbase × height.

Table 4-1 Cube/Rack Dimensions

Version Dimensions1 I/O Slots

UEINet 4.1” x 4.0” x 2.7” slots for 1 I/O board

DNA-PPC5-1G 4.1” x 5.0” x 4.0” slots for up to 3 I/O boards

DNA-PPC8-1G 4.1” x 5.0” x 5.8” slots for up to 6 I/O boards

DNA-PPC9-1G 4.1” x 5.0” x 6.6” slots for up to 7 I/O boards

DNF-4-1G 16.75” x 7.2” x 1.75” slots for up to 4 I/O boards

DNR-6-1G 10.5” x 6.2” x 5.25” slots for up to 6 I/O boards

DNR-12-1G 17.5” x 6.2” x 5.25” slots for up to 12 I/O boards
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4.9 Pinout 
Diagrams

Pinout diagrams for the Power In, synchronization (SYNC) port, and 
DIAG port connectors are shown below in Figure 4-16. 

Figure 4-16  SoloX Cube/Rack Pinout

4.10 Wiring I/O 
Boards

Refer to the applicable I/O board manuals and datasheets for pinouts and 
proper wiring to boards.
Datasheets and manuals are provided on our website at www.ueidaq.com.

4.11 Repairing or 
Upgrading a 
Cube/RACK

PowerDNA SoloX Cube/Rack systems come from the factory calibrated and 
pre-configured with UEI drivers loaded in memory. 
If you encounter a problem with your Cube/Rack, note that individual modules 
are designed for field replacement and are not suited for field repairs.
If you want to remove and replace individual boards or other system modules, 
you can do that in the field once you power down your system. You can also 
rearrange the locations of boards within the enclosure at any time; however, 
note that you may need to reprogram I/O board locations in your application. 
Refer to Section 4.11.1 for more information.

No Hot Swapping

Always turn POWER OFF before performing maintenance on a UEI system. 
Failure to observe this warning may result in damage to the equipment and 
possible injury to personnel.

1 Rsvd (NC)
2 Rsvd (NC)
3 Rsvd (NC)
4 Rsvd (NC)
5 NC
6 A9 RX
7 A9 TX
8 M4 RX
9 M4 TX

10

DIAG

DGnd

1

6

1 +5 V
2 +5 V
3 Gnd
4 Sync Out 2
5 Gnd
6 Sync In 2
7 Gnd
8 Sync Out 1
9 Gnd

10

Sync

Sync In 1

1

 Mating connector is Hirose PN 1X30G-B-10S-CV(7.0)

Mating connector is Hirose PN ST40-10S-CV

VIn

Power In

 Mating connector is Molex PN 39-01-4040

(DNA, DNR-6, DNR-12)

VInGnd Gnd

Chassis

Power In

 Mating connector is Conxall PN 6380-3SG-311

(DNF-4)

VIn Gnd
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If you want to enhance, repair, or otherwise modify a specific I/O board, you 
must send the module back to the factory or to your local distributor. 
This process requires that you request an RMA number from UEI before 
shipping. To do so, contact support@ueidaq.com and provide the following 
information: 

1. Model Number of the unit, (e.g. DNR-AI-217)

2. Serial Number of the unit

3. Reason for return, (e.g. faulty channel, needs calibration, etc.)

UEI will process the request and issue an RMA number.

4.11.1 Removing and 
Replacing I/O 
Boards

For all chassis types, individual boards can be removed and replaced in the field 
once power is removed from the chassis. 
You can rearrange the locations of boards within the enclosure at any time; 
however, note that when installing I/O boards in a Cube chassis, you may need 
to move jumpers on the I/O board(s).

Removing and Replacing I/O Boards in a Cube Chassis

Each Cube I/O board includes a jumper block that identifies the physical position 
of the I/O board in the stack. If you change the order of your I/O boards in your 
Cube or install a new board, you may need to adjust corresponding hardware 
jumpers. This is only applicable in Cube systems (jumpers are not used in DNR 
or DNF I/O boards for installation in a DNR-12-1G, DNR-6-1G, or DNF-4-1G 
system.)
Refer to the PowerDNA Field Installation Guide for more information about 
installing I/O boards and setting jumper positions in Cubes.

NOTE: For additional maintenance procedures, please refer to 
the DNA Maintenance Manual for Cube-based chassis and 
the DNR Maintenance Manual for RACK-based chassis.

4.12 Disabling 
Writes to 
Flash/
EEPROM 
(NVRAM)

Writing non-volatile memory (NVRAM) can be disabled by installing a hardware 
jumper on the CPU board. 
This hardware security feature ensures that no user data will be stored on the 
Cube/Rack after power is disconnected. 

NOTE: Writes to the EEPROM on the DNx-AO-358 and DNx-AO-364 are not 
disabled by this process. 
Applications that must disable all NVRAM writes should not include the 
DNx-AO-358 and DNx-AO-364 products in their system.

Installing the NVRAM protection jumper requires removal and replacement of 
the DNx-POWER-1GB board in the Cube/Rack chassis. In general UEI 
recommends that a Cube/Rack be returned to the factory for adding or replacing 
boards. UEI can install and remove jumpers as needed.

4.12.1 Disabling 
NVRAM Writes 
(Cube)

To disable writes to Flash/EEPROM on a Cube system, do the following:
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STEP 1: Disconnect power to the Cube.
STEP 2: Attach a grounding strap to your wrist, and follow normal ESD procedures.
STEP 3: Disconnect all cables from the Cube.

If the Cube has a fan, remove the screws securing the rear cover to the housing. 
Lay the cover flat on the bench and disconnect the fan power cable from the 
board stack.

STEP 4: Remove the DNx-POWER-1GB board from the Cube chassis: 

a. Using a 3/16-inch nut driver, unscrew all jack screws securing the 37- and 62-
pin D-sub connectors to the faceplate. 

b. Remove the four screws located on the corners of the faceplate. Use an
appropriate screwdriver to avoid stripping the screws.

c. Remove the faceplate. Carefully push or pull the faceplate/board stack
assembly out of the cube housing. Exercise caution to not bend or damage
the pins on the last I/O board. Place the assembly onto an anti-static surface.

d. Identify the board labeled DNx-POWER-1GB in the stack (it is the second
from the top and includes the Molex connector).

e. Carefully separate the I/O board stack so that the DNx-POWER-1GB board
can be removed. Carefully pull boards apart and do NOT bend or damage
any pins.

STEP 5: Locate the J1 jumper block on the DNx-POWER-1GB board, and insert a jumper 
between pins 13 and 15. Refer to Figure 4-17 for pin locations.

Figure 4-17  NVRAM Protection Jumper Pins

STEP 6: Reassemble the Cube: 

a. Carefully align all pins and reassemble the stack of boards.

b. Verify that all boards are in the correct positions and then attach the faceplate
to the stack using the jack screws previously removed. Use a 3/16-inch nut
driver. Do not overtighten (5 lb-in. max torque).
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NOTE: It may be helpful to power up the stack outside of the housing so that 
you can verify your assembly. Once verified, disconnect the power and 
proceed to Step c.

c. Insert the stack into the cube housing, carefully aligning all boards with the
correct slots in the housing.

d. Slide the faceplate/stack assembly into the housing so that the faceplate is
seated properly in the housing.

e. Reinsert the mounting screws for the faceplate and tighten securely. Do not
overtighten. Check the DNx-POWER-1GB board LEDs, RESET button, and
sync port at the front of the carrier. The RESET button should be free to
move.

STEP 7: Reattach all cables to their respective connectors:
If the Cube has a fan, reattach the fan power cable and secure the rear cover to 
Cube.

STEP 8: Restore power to the system.

NOTE: If your Cube is repeatedly rebooting (i.e. all the CPU/POWER module 
LEDs stay on), check to ensure that the RESET pushbutton has not 
become stuck behind the faceplate.

4.12.2 Disabling 
NVRAM Writes 
(Rack)

To disable writes to Flash/EEPROM on a RACK, HalfRACK, or FLATRACK 
system, do the following:

STEP 1: Turn off power to the Rack.
STEP 2: Attach a grounding strap to your wrist, and follow normal ESD procedures.
STEP 3: Disconnect all cables from the SoloX CPU/POWER module (refer to Figure 2-1 

for location of CPU/POWER module).
STEP 4: Remove CPU/POWER module from the enclosure: 

a. Using a torque screwdriver, loosen the thumbscrews securing the CPU/
POWER module to the chassis.

b. Lift the insertion/extraction lever and slide out the module. 

STEP 5: Remove the upper CPU board from its carrier (see Figure 4-18):

Care must be taken when removing PCB boards from a carrier. Over-
tightening or forcing hardware can crack boards, damage components 
and/or leave the board inoperable.
Loosen 1 Phillips screw (4-40 x 1 inch) from the front of the carrier and 2 Phillips 
screws from the sides. Gently slide out the upper board.
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Figure 4-18  Isometric Diagram of CPU/POWER Module Carrier

STEP 6: Remove the lower DNx-POWER-1GB board from the carrier:
Loosen 2 Phillips screws (4-40 x 1 inch) from the bottom of the carrier using a 
1/4” locknut driver and a Phillips screwdriver. Remove 2 screws, 4 plastic 
spacers, and 2 locknuts. Gently slide out the lower board.

STEP 7: Locate the J1 jumper block on the DNx-POWER-1GB board, and insert a jumper 
between pins 13 and 15. 
Refer to Figure 4-17 for pin locations.

STEP 8: Reinstall the lower DNx-POWER-1GB board into the carrier: 

a. Gently slide the lower board into the carrier.

b. Align LEDs, RESET button, and sync connector with openings on carrier: Be
sure the RESET button is free to move.

c. Slide and align one plastic spacer between the carrier and the lower board.

d. From the bottom of the carrier, insert the Phillips screw (4-40 x 1 inch)
through the carrier, plastic spacer, and PCB board.

e. Slide a plastic spacer onto the Phillips screw and install locknut.

f. Gently tighten with 1/4” locknut driver and Phillips screwdriver, taking care
not to over-tighten. Over-tightening can crack PCB boards.

STEP 9: Reinstall the upper CPU board into the carrier: 

a. Gently slide the upper board into carrier. Care must be taken when sliding the
board in; electrolytic capacitors on the lower board can get damaged if they
scrape against the upper board.

b. Align CPU board connectors with openings on carrier.

c. Reinsert Phillips screw through the front of the carrier and two Phillips screws
from the sides. Take care not to over-tighten. 

STEP 10: Insert the CPU/POWER module into the enclosure:

a. Fully insert the module into the guides and use the insertion lever to seat the
board into the backplane connector.

b. Using the torque screwdriver set to 5 in-lb, screw in the thumbscrews until the
torque screwdriver clicks.
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STEP 11: Reattach all cables to the CPU/POWER module.
STEP 12: Restore power to the system.

NOTE: If your Rack is repeatedly rebooting (i.e. all the CPU/POWER module 
LEDs stay on), check to ensure that the RESET pushbutton has not 
become stuck behind the faceplate.
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Chapter 5 PowerDNA Explorer

PowerDNA Explorer is a GUI-based application for communicating with your 
UEI Cube/RACK systems. This chapter provides an overview of PowerDNA 
Explorer capabilities:

• Overview of PowerDNA Explorer (Section 5.1)

• Launching PowerDNA Explorer (Section 5.2)

• Connecting to the Cube/RACK (Section 5.3)

• Displaying CPU/POWER Module Diagnostics (Section 5.4)

• Obtaining a Hardware Report (Section 5.5)

• Viewing I/O Boards (Section 5.6)

• Setting Timeouts (Section 5.7)

5.1 Overview of 
PowerDNA 
Explorer

PowerDNA Explorer provides a platform for the following:
• Displays diagnostic data on CPU / Power module (temperatures, volt-

age supply measurements, error conditions)

• Reports serial numbers and version information about the CPU/Power
module and I/O boards

• Provides hardware report for the CPU/Power module and all I/O boards

• Allows users to perform basic read, write, and configuration functionality
on I/O boards for orientation and troubleshooting purposes

• Allows users to configure initial and shutdown output levels on sup-
ported boards

• Discovers and interacts with other UEI systems on a range of user-
defined IP addresses on a network

5.2 Launching 
PowerDNA 
Explorer

PowerDNA Explorer can be used on Windows or Linux systems.
• On Windows systems, access PowerDNA Explorer from the Start menu:

Start » All Programs » UEI » PowerDNA » PowerDNA Explorer 

• On Linux systems, access PowerDNA Explorer under the UEI installa-
tion directory (<PowerDNA-x.y.z>/explorer) by typing:
java -jar PowerDNAExplorer.jar

UEI provides a PowerDNA Explorer DEMO with the installation that lets you 
safely explore the menus and I/O board screens without using actual hardware. 
The DEMO application is located in the same directory as the PowerDNA 
Explorer executable.
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5.3 Connecting to 
the Cube/
RACK

To connect to your Cube/RACK system in PowerDNA Explorer:

STEP 1: Provide power to the Cube/Rack. 
STEP 2: Connect an Ethernet cable between your PC Ethernet port and the NIC 1 port on 

the Cube/Rack (NIC 2 is reserved for Diagnostics.)
STEP 3: Launch PowerDNA Explorer and click the Scan Network button (Figure 5-1). 

All discovered UEI systems display to the left in the Device Tree panel. Each UEI 
system is named IOM-####, where #### is the serial number of the Cube/Rack. 

Figure 5-1  Initial Screen of PowerDNA Explorer

STEP 4: If your Cube/Rack was not found, check that the IP Address of your Cube/Rack 
is within the range scanned by PowerDNA Explorer:

a. Navigate to Network » Address Ranges in the PowerDNA Explorer menu
(Figure 5-2).

Figure 5-2  View Address Ranges

Scan 
Network

Cube/Rack 
System

“Device Tree” 
Panel

“Settings” 
Panel
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b. An Address Ranges window will open. If the IP address of your Cube/Rack is
not in the listed range, click Edit to modify the existing range or click Add to
add a new subnet or range (Figure 5-3).

Figure 5-3  Address Ranges Window

c. Enter range information and click OK in the Edit Address Range dialog 
(Figure 5-4). Then click Done in the Address Ranges window.

Figure 5-4  Edit Address Range Dialog

d. Scan the network for UEI systems in the newly specified range either by
selecting Network » Scan Network or clicking the Scan Network button
(see Figure 5-1 on the previous page).

After a scan, the device tree is populated with all central controllers, UEI sys-
tems (Racks and Cubes), and I/O boards accessible from the network, as fil-
tered through the range defined in the Address Ranges window.
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5.4 Displaying 
CPU/POWER 
Module 
Diagnostics

When you click on an IOM name in the left-hand “Device Tree panel”, the right-
hand “Settings” panel shows information about the system’s CPU and power 
boards.
The screenshot below shows example data for the SoloX CPU/POWER module:

Figure 5-5  CPU/POWER Module  Panel (DNR-12-1G)

The rest of the panel displays voltages, currents, temperatures and other 
diagnostic information. In Figure 5-5, the “CPU/NIC Layer” sub-panel shows 
data for the CPU/POWER 2-board module. For descriptions of “CPU/NIC Layer” 
LED states, refer to Table 3-5 for the Cube or Table 2-10 for the Rack.
The “Power Layer” sub-panel shows data for the DNR/DNF Power module, 
which is found on RACK-based systems only. Cube-based systems will not 
show the “Power Layer” display. For a description of “Power Layer” LED states, 
refer to Table 2-11.

Table 5-1 CPU/POWER Settings Panel Descriptions

Field Description

Name Read/write UEI system name. 
To change: Edit field and then click Network » Store Config. 

Model Read the model number.

FW Ver Read the version of the firmware installed on the system.

S/N Read the serial number of the system.

MAC Read the MAC address.

IP Address “IP 1” displays the primary NIC1 address. 
“IP2” displays the diagnostic NIC2 address. 
Refer to Section 4.4 for instructions on changing IP addresses.

Mode Displays the current mode of the system: 
Initialization, Configuration, Operation, or Shutdown. 
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5.5 Obtaining a 
Hardware 
Report

The hardware report provides diagnostic and status data, versioning, and more 
for your Cube/Rack system, CPU/POWER module, and all installed I/O boards.
To obtain a hardware report, select View » Show Hardware Report.

Figure 5-6  Example of a Hardware Report



PowerDNA for SoloX Cube & RACK Data Acquisition Systems
Chapter 5 74

PowerDNA Explorer

January 2022  www.ueidaq.com
508.921.4600 

© Copyright 2022
United Electronic Industries, Inc.

5.6 Viewing I/O 
Boards

To view a list of installed I/O boards, double-click the name of your Cube/Rack 
(e.g., IOM-####) in the Device Tree panel. Click any available I/O board to 
display board details in the Settings panel (see Figure 5-7). 

Figure 5-7  Viewing I/O Boards

Each I/O board has the following settings:
• Model shows the model number of the device.

• Info shows some key features of the device: A for analog, D for digital,
In for input, Out for output, and a number of channels available.

• S/N shows the device serial number.

• Mfg. Date shows the manufacturing date.

• Cal. Date shows the date of the last calibration.

• Logic Ver. shows the logic version programmed on the board’s FPGA.

• Dev. Num. is the device number (DEVN), which indicates the board’s
position in the chassis relative to other boards. The board’s physical
location is shown in the Cube/RACK image to the right.

• Modifiable is a checkbox which, when unchecked, prevents parameters
from being changed.

Other I/O board settings vary on a per-board basis. 

View Layer User Manual Show Wiring Diagram
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5.6.1 Interacting 
with I/O 
Boards

PowerDNA Explorer can be used to learn about the board’s capabilities and to 
troubleshoot your application (e.g., isolating hardware vs programming issues). 
Typically, only a subset of I/O board settings are available through PowerDNA 
Explorer. More advanced features can be accessed through the high-level and/
or low-level API. 
Please refer to your I/O board’s user manual for information about interacting 
with your board in Explorer. 
To view the I/O board’s user manual, click the View Layer User Manual button 
or visit its product page at www.ueidaq.com.

5.6.2 Displaying 
Pinout for I/O 
Boards

You can quickly view a wiring diagram for an I/O board by selecting 
View » Show Wiring Diagram (or click the Show Wiring Diagram button). 
The same diagram is provided in the I/O board’s user manual and datasheet. 
The user manual also includes pinout descriptions and wiring tips. 

Figure 5-8  Example of a Wiring Diagram Display
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5.7 Setting 
Timeouts

You can specify PowerDNA Explorer timeout intervals by opening the
File » Preferences dialog (Figure 5-9).

Figure 5-9  PowerDNA Explorer Timeout Preferences

The following timeout intervals can be changed:
• PowerDNA Command Timeout sets the length of time PowerDNA

Explorer will wait for response from a CPU/NIC Core Module before giv-
ing up with an error. It defaults to 100 milliseconds.

• Firmware Update Timeout specifies the length of time PowerDNA
Explorer will wait when updating firmware via Network » Update Firm-
ware... The firmware timeout defaults to 120 seconds.
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Chapter 6 Programming CPU Parameters

This chapter provides descriptions of configuration and diagnostic PowerDNA 
SoloX Cube/Rack CPU commands that can be issued over a serial terminal. 
The following information is provided:

• Connecting to the CPU Module (Section 6.1)
• Startup Sequence (Section 6.2)

• Serial Interface Commands (Section 6.3)

To program your application, please refer to the example code and additional 
documentation that is provided with the installation (e.g., Getting Started with 
your PowerDNA Application, I/O board manuals, PowerDNA API Reference 
Manual).

6.1 Connecting to 
the CPU 
Module

There are two ways to set CPU Core Module parameters. 
The first method is to use the serial interface and enter commands at the DQ> 
prompt. Refer to “Connecting to Cube/RACK via Serial Port” on page 42 for 
instructions on getting to the DQ> prompt.
The second method is the use of DAQBIOS calls by running an application on 
the host PC. 

NOTE: The rest of this chapter provides descriptions of setting and reading 
CPU parameters using the serial interface. For more information about 
accessing CPU core parameters via your application, please refer to the 
PowerDNA API Reference Manual.

6.2 Startup 
Sequence

After the Cube/Rack is powered on or reset, the processor reads the boot-up 
sequence located at the U-Boot address shown below in Table 6-1. The U-boot 
monitor initializes the processor and the address map, retrieves information 
from the parameter sector of the flash memory and tests system memory and 
other system resources.
When the PowerDNA SoloX Cube/Rack starts booting, you have the option of 
interrupting the boot via a serial terminal connection between the PowerDNA 
SoloX Cube/Rack and a host PC. If the autoboot process is interrupted, the U-
Boot monitor stops loading firmware into memory and instead brings up the U-
Boot command prompt => (to load new firmware, for example).
Otherwise, U-Boot reads the firmware from QSPI Flash and stores it in SDRAM 
at 0x80000000. U-Boot then executes the bootcmd command sequence, which 
is stored as a U-Boot environment parameter. The bootcmd sequence typically 
ends with go 0x80000000, which launches the firmware code located at 
address 0x80000000.
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6.3 Serial 
Interface 
Commands

The following CPU commands are executed via the serial interface. Refer to 
“Connecting to Cube/RACK via Serial Port” on page 42 for instructions on 
establishing a serial connection.

6.3.1 View Available 
Commands

The help command provides a list of available commands:

Table 6-1 Memory Map for PowerDNA SoloX Cube/Rack CPU (DNx-CPU-1G-11)

Device Start Address End Address Size Description

SDRAM 0x80000000 0xBFFFFFFF 1GB SDRAM Address

QSPI Flash (U-Boot) 0x60000000 0x600DFFFF 896kB QSPI HDR + U-Boot

QSPI Flash (U-Boot Env) 0x600E0000 0x600EFFFF 64 kB U-Boot Environment params

QSPI Flash (PDNA Params) 0x600F0000 0x600FFFFF 64 kB PowerDNA parameters

QSPI Flash (uC/OS FW) 0x60200000 0x600DFFFF 8 MB PowerDNA SoloX firmware

DQ> help

    help Display this help message      help 
     set Set parameter                  set option value
    show Show parameters                show 
   store Store parameters (flash)       store 
    flrd Re-read flash (flash)          flrd 
      mw Write wr <addr> <val> [width,b] mw 
      mr Read rd <addr> [width,b] [size] mr 
    time Show/Set time                  time [hh:mm:ss] [mm/dd/yyyy]
    pswd Set password                   pswd {user|su}
      ps Show process state #           ps [value]
    test Test something                 test [test number]
   simod System Init/Module Cal         simod [routine]
 default Default parameters             default 
   reset Reset system                   reset 
  dqping Send DQ_ECHO to <mac addr>     dqping 
    mode Set current mode               mode {init|config|oper|shutdown} [ID]
     log Display log content            log [start [end]] -1 = clear
    logf Find entry in the log          logf marker [start [end]]
     ver Show firmware version          ver [all]
  devtbl Show all devices/layers        devtbl [logic|verbose|status]
 netstat Show network statistics        netstat 
     pdj Print device object            pdj <devno> cl
    stat Display status                 stat [cpu]
     nif Display nif object             nif 
   clear Clear terminal                 clear 
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6.3.2 Show System 
Parameters

The show command is one of the most frequently used commands. 
show provides a list of Cube/Rack system parameters:

DQ> show

        name: "IOM-224359"
       model: 4012
      serial: 0224359
      option: 000B
        fwct: 1.2.0.0
         mac: 00:0C:94:03:6C:67
         srv: 192.168.100.1
          ip: 192.168.100.2 (DOWN)
     gateway: 192.168.100.1
     netmask: 255.255.255.0
        mac2: 00:0C:94:F3:6C:67
        srv2: 192.168.101.1
         ip2: 192.168.101.2 (DOWN)
    gateway2: 192.168.101.1
    netmask2: 255.255.255.0
         udp: 6334
     license: ""
    Manufactured 10/1/2020
    Calibrated 10/15/2020
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6.3.3 Change 
System 
Parameters

To view a list of parameters that can be changed, type set followed by the Enter 
key. The default user password is powerdna.

To change a parameter, type set <parameter name> <value>. Once 
parameters are set, you must store them into non-volatile flash memory with the 
store command. The following example sets the IP address of NIC2:

Reset the system for the new parameters to take effect.

6.3.4 Reset System The reset command performs a physical reset of the CPU and initiates the full 
startup sequence on the PowerDNA SoloX Cube/Rack system.

DQ> set 
Enter user password > ********

Valid 'set' options:
        name: <Device name>
       model: <Model id>
      serial: <Serial #>
      option: <Option>
        fwct: <autorun.runtype.portnum.umports>
         mac: <ethernet address port 1>
         srv: <Default IP address port 1>
          ip: <IOM IP address port 1>
     gateway: <gateway IP address port 1>
     netmask: <netmask port 1>
        mac2: <ethernet address port 2>
        srv2: <Default IP address port 2>
         ip2: <diagnostic port IP address>
    gateway2: <diagnostic port gateway IP>
    netmask2: <diagnostic port netmask>
         udp: <udp port (dec)>
     license: license string

DQ> set ip2 192.168.100.3
DQ> store
ops_flwr: 1240 bytes stored! CRC=0x29140499 OLD=0x18AC7439
Configuration stored

DQ> reset
Stopping DaqBIOS

U-Boot 2017.03-imx_v2017.03_4.9.88_2.0.0_ga+gb76bb1b (Dec 13 2019 - 18:30:03 
-0500)

<...many U-boot messages deleted...>

DQ> 
Two independent NICs
DQ>
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6.3.5 Change 
Password

Some commands (such as mr, mw, set, and store) require entering a user 
password. Once the password is entered, these commands become enabled 
until the system is reset. 
There are two levels of password protection available. The first is user level and 
the second is super-user level. Super-user level is currently used only for 
updating firmware over Ethernet.

• DQ> pswd user sets up a user level password. 
First, you’ll be asked to enter your current password and then (if it
matches) to enter the new password twice.

• DQ> pswd su sets up super-user level password. 
First, you’ll be asked to enter your current super-user password and
then (if it matches) to enter the new super-user password twice.

PowerDNA SoloX Cube/Rack systems come with both default passwords set to 
powerdna. If you need to reset your password, use the following

• DQ> pswd reset 

Some DaqBIOS commands require entering a user or super-user password. 
Use DqCmdSetPassword() before calling these functions. The PowerDNA 
API Reference Manual notes which functions are password-protected.

6.3.6 Display I/O 
Boards

The devtbl command is a frequently used command. This command displays 
all boards (I/O, power, and CPU) installed and recognized by your system.

where
• Model is the model number of the board

• Option indicates the version of the board. Option 1 corresponds to the
base model.

• S/N is the serial number

• DevN is the device order in the chassis: 0 corresponds to the I/O board
in the first position, etc. (CPU and power boards use DevNs after I/O).
Use these device numbers in your user application to address I/O
boards.

The other columns are for UEI internal use.

DQ> devtbl

 Address   Irq  Model Option  Phy/Virt  S/N    Pri DevN
-------------------------------------------------------
0x54000000   2    101    1    phys   1269599     10   0
0x54010000   2    255    1    phys   1249193     20   1
0x54020000   2    261    1    phys   1278460     30   2
0x540C0000   2     20    1    phys   1223814     40   3
0x540D0000   3     40    1    phys   1234567     50   4
0x540E0000   3     11    B     cpu   0224359      0  14
-------------------------------------------------------
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The devtbl command with the logic option added displays the logic version 
programmed on each board’s FPGA:

The devtbl command with the verbose option added displays additional 
detailed information about each installed board:

DQ> devtbl logic
Logic information:
DevN Mod-opt Logic      CLI   CLO  LogOption
-----------------------------------------------
  0  101-001 02.14.FB  2048  2048  81008064
  1  255-001 02.12.5A     0     0   3008004
  2  261-001 02.15.07  4096   512  810824E0
  3  020-001 02.14.46     0     0   100800F
  4  040-001 02.14.BC     0     0  81000081
 14 4012-00B 02.14.9C     0     0    91FFC8
-----------------------------------------------

DQ> devtbl verbose
Logic capabilities:
Device:0 model:101-001
    - Sample counters are available
    - IS-->NIS selector is disabled in cli_sync module
    - Standard input channel list implementation used
    - Standard output channel list implementation used
    - Disabled NIS-->IS selector in cli_sync module

Device:1 model:255-001
    - Sample counters are available
    - IS-->NIS selector is disabled in cli_sync module
    - Disabled NIS-->IS selector in cli_sync module

Device:2 model:261-001
    - Sample counters are available
    - 16.5MHz serial isolation interface speed based on 66MHz system clock
    - 2-wire interface is used
    - PWM output enabled for the TMR0/TMR1 timers in SYNC module
    - Standard input channel list implementation used
    - Standard output channel list implementation used

Device:3 model:020-001
    - Sample counters are available
    - IS-->NIS selector is disabled in cli_sync module
    - Disabled triggering in cli_sync module
    - Disabled NIS-->IS selector in cli_sync module
    - Disabled SYNC lines part in cli_sync module
    - 8-bit output test port is unavailable

Device:4 model:040-001
    - Sample counters are available
    - PWM output enabled for the TMR0/TMR1 timers in SYNC module
    - 8-bit output test port is unavailable
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6.3.7 Display Power 
Diagnostics

Typing simod 5 at the serial prompt displays diagnostic information from the 
Cube/Rack power board(s). 
In the example below, “DNR_PWR” is the dedicated DNR/DNF Power module 
and “DNR_PWR_1G” is the power board on the SoloX CPU/POWER module. 
Diagnostic information includes voltage readings on each of the 2.5 V, 24 V, 1.2 
V, 3.3 V, and 1.5 V supplies, as well as temperature and current measurements.

6.3.8 Monitor CPU 
Buffer Usage

Typing simod 15 at the serial prompt causes the CPU utilization percentage to 
continuously print to the serial console. 
simod 15 can be used to monitor the CPU load while your application is 
sending and receiving commands and data over Ethernet.

6.3.9 Change Date 
and Time

Enter time at the serial prompt to view the current date and time on the 
PowerDNA SoloX Cube/Rack system:

DQ> simod 5

Periodic failures code: 0

DNR_PWR layer 20 diagnostics

   2.5DNR= 2.514*   2.5NIC= 2.509*   3.3DNR= 3.340*   3.3NIC= 3.312*
    24DNR=24.225*    24NIC=24.186*      Vin=22.604*   1.5DNR= 1.606*
   1.2DNR= 1.298*     Vfan= 8.017*      Iin= 0.863*    Temp1=24.580*
    Temp2=24.283*

DNR_PWR_1G layer diagnostics

   2.5DNx= 2.507*     GND1= 0.000*
   3.3DNx= 3.331*    U-Cap= 5.306*
    24DNx=24.263*      Vin=23.779*
   1.5DNx= 1.616*   1.2DNx= 1.303@
    VfanX= 0.025!
    I 3.3= 0.751*
    Temp1=27.882*    Temp2=27.912*
Unit logged 215033046.4 hours

DQ> simod 15
Printing statistics
+cpu:0
+cpu:91
+cpu:2
+cpu:1

DQ> time
Current time: 06:23:57 09/10/2021
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You can also use the time command to set a new date and time:

Date and time are stored in the battery-backed real-time clock chip.

DQ> time 11/19/2021
DQ> time 15:48:00
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Appendix A
SoloX Accessories

A.1  Cables and 
STPs

The following cables and STP boards are designed for the SoloX CPU module. 

CBL-SX6-DIAG 

This is a 10-conductor cable with 10-pin multi-purpose plug connector on one
end (Hirose IX30G-B-10S-CV(7.0)) and a DB-9 connector on the other. 
It is made with round, heavy-shielded cable; 3.75 ft (114 cm) long, weight of 
2.74 ounces or 77.6 grams.

CBL-SX6-SYNC 

This is a 10-conductor cable with 10-pin multi-purpose plug connectors on both
ends (Hirose IX30G-B-10S-CV(7.0)). It is made with round, heavy-shielded
cable; 3.75 ft (114 cm) long, weight of 2.50 ounces or 70.9 grams.

STP-SX6-DIAG 

The STP-SX6-DIAG is a Screw Terminal Panel with one 10-pin multi-purpose
plug connector (Hirose 1X61G-B-10P, which mates with IX30G-B-10S-CV(7.0)),
1 RJ-50 SYNC jack, 1 10-position terminal block (JT1) plus two DB-9 serial
sockets (P1 for A9 and P2 for M4). 

The dimensions of the STP-SX6-DIAG board are 2.85w x 4.2d x1.2h inch or 
7.24 x 10.67 x 3 cm (with standoffs). The weight of the STP-62 board is 
3.56 ounces or 100.79 grams.

Figure A-1  Board Layout of STP-SX6-DIAG Screw Terminal Panel

�

NOTE:
P1: DB-9 connector for A9 processor
P2: DB-9 connector for M4 processor
FJ1, J1, JL1, JT1: Reserved
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Appendix B
Network Interface Card Configuration

B.1  Configuring an 
Ethernet Card 
on Windows

This section describes how to configure an Ethernet card on a Windows 10 host
PC.

B.1.1 Install 
Ethernet Card

If you already have an Ethernet card installed, skip ahead to the next section,
“Configure TCP/IPv4”.

If you have just added an Ethernet card, install it by doing the following:

STEP 1: Click Start » Control Panel from the Windows menu. 
STEP 2: Under “Hardware and Sound”, click Add a device and follow the on-screen 

instructions.

NOTE: We recommend that you allow Windows to search for and install your 
Ethernet card automatically. If Windows does not find your Ethernet 
card, you will need to install it manually by following the manufacturer's 
instructions. 

Once your Ethernet card has been installed, continue to the next section.

B.1.2 Configure 
TCP/IPv4

STEP 1: Click Start » Control Panel from the Windows menu.

STEP 2: In the Control Panel window, click View network status and tasks (Figure B-1).

.

Figure B-1  Control Panel Window

STEP 3: In the left sidebar of the Network and Sharing Center window, click Change 
adapter settings (Figure B-2). The Ethernet port on your PC should not have a 
cable attached at this time. 
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Figure B-2  Network and Sharing Center Window

STEP 4: In the Network Connections window, double-click the network interface you are 
connecting to the Cube/RACK. This will typically be labeled Ethernet (Figure B-
3) or Local Area Connection if you are using your primary network interface card 
(NIC). 

Figure B-3  Network Connections Window

STEP 5: In the Ethernet Properties window, verify the Networking tab is selected, and 
double-click Internet Protocol Version 4 (TCP/IPv4) (Figure B-4).

Figure B-4  Ethernet Properties Window
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STEP 6: In the Internet Protocol Version 4 (TCP/IPv4) window, click the Use the follow-
ing IP address button. Note any addresses listed in the IP Address, Subnet 
Mask, Default Gateway, Preferred DNS Server or Alternate DNS Server fields. 
You may want to re-enter them later to reconfigure your PC when you are done 
with the Cube/RACK.

Figure B-5  Internet Protocol Version 4 (TCP/IPv4) Window

STEP 7: Enter the IP Address as 192.168.100.1 and the Subnet mask as 255.255.255.0 
(Figure B-5).

Setting the host PC NIC address to 192.168.100.1 with a subnet mask of
255.255.255.0 allows the host PC to communicate with components with IP
addresses from 192.168.100.2 through 192.168.100.254 via that NIC port. All
UEI Cubes and RACKs on this network will need to have unique IP addresses in
that range. (The default IP address of the Cube/RACK is 192.168.100.2, now
within the required range. 

STEP 8: Click OK and/or Close and close out of network setup windows.

For instructions on setting the IP address, subnet mask, and default gateway on
the UEI chassis, refer to “Updating IP Addresses” on page 44.
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Appendix C
Field Replacement of Fuses

C.1  Fuses on DNA 
and DNR 
Boards

Some boards used in UEI Cube and Rack systems require field replacement of
fuses when unexpected overloads occur. Locations of these fuses are shown in
Figure C-1 through Figure C-3. Part numbers for the replacement fuses are
listed Table C-1.
 

Figure C-1  Location of Fuse for I/O Boards Equipped with a Fuse

Table C-1 DNA/DNR Replacement Fuses

UEI Fuse 
ID (Board) Rating

UEI Part 
No. Description Mfr. Mfr P/N

F1 5A 925-5125 FUSE 5A 125V SLO SMD SILVER T/R Littlefuse 0454005.MR

F2 5A 925-5125 FUSE 5A 125V SLO SMD SILVER T/R Littlefuse 0454005.MR

F3 (DC) 5A 925-5125 FUSE 5A 125V SLO SMD SILVER T/R Littlefuse 0454005.MR

F3 (1GB) 10A 925-1125 FUSE 10A 125V FAST NAN02 SMD Littlefuse 0451010.MRL

F4 5A 925-5125 FUSE 5A 125V SLO SMD SILVER T/R Littlefuse 0454005.MR
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Figure C-2  Location of Fuses for DNR-POWER-DC Board 

Figure C-3  Location of Fuses for DNx-POWER-1GB Board

   
 D

N
R

 1
20

-p
in

 B
us

 C
on

ne
ct

or

F1 (5A)

F3 (5A)

F2 (5A)

F4 (5A)

J1

D
N

A 
12

0-
pi

n 
Bu

s 
C

on
ne

ct
or

F1 (5A)

F3
 (1

0A
)

F2 (5A)
J1


	PowerDNA® for SoloX Cube & RACKTM Data Acquisition Systems — User Manual
	Table of Contents
	List of Figures
	List of Tables
	Chapter 1 Introduction
	1.1 Organization of this Manual
	1.2 Product Versions Described in This Manual
	1.2.1 Comparison with Other Product Versions

	1.3 Manual Conventions
	1.4 Related Resources

	Chapter 2 PowerDNA SoloX RACK System
	2.1 SoloX RACK Overview
	2.1.1 RACK System Components

	2.2 Specifications
	2.3 Key Features
	2.4 RACK Enclosures
	2.4.1 DNR-12-1G Enclosure
	2.4.2 DNR-6-1G Enclosure
	2.4.3 DNF-4-1G Enclosure
	2.4.4 Filler Panel & Mounting Bracket
	2.4.5 RACK Air Flow

	2.5 CPU/POWER Module
	2.5.1 CPU Processor
	2.5.2 FPGA
	2.5.3 Memory and Storage
	2.5.4 Ethernet Ports
	2.5.5 Real-time Clock
	2.5.6 RS-232 Ports (DIAG)
	2.5.7 Sync Port
	2.5.8 System Power Control & Monitoring
	2.5.9 CPU/POWER Module Ports & LEDs

	2.6 DNR/DNF Power Module
	2.6.1 Power Management Features
	2.6.2 DNR Power Module Ports & LEDs
	2.6.3 DC Power Thresholds

	2.7 DNR-Buffer Module
	2.8 RACK I/O Boards

	Chapter 3 PowerDNA SoloX Cube System
	3.1 SoloX Cube Overview
	3.1.1 Cube System Components

	3.2 Specifications
	3.3 Key Features
	3.4 Cube Enclosure
	3.4.1 Fans & Air Flow

	3.5 CPU/POWER Module
	3.5.1 CPU Processor
	3.5.2 FPGA
	3.5.3 Memory and Storage
	3.5.4 Ethernet Ports
	3.5.5 Real-time Clock
	3.5.6 RS-232 Ports (DIAG)
	3.5.7 Sync Port
	3.5.8 Ports & LEDs
	3.5.9 System Power Control & Monitoring

	3.6 Cube I/O Boards

	Chapter 4 Installation and Configuration
	4.1 Shipment Contents
	4.2 Installing Software
	4.2.1 Installing Software on Windows
	4.2.2 Installing Software on Linux

	4.3 Initial Bootup
	4.3.1 Connecting to Cube/RACK via PowerDNA Explorer
	4.3.2 Connecting to Cube/RACK via Serial Port

	4.4 Updating IP Addresses
	4.4.1 When Should You Change the IP Address?
	4.4.2 Updating IP Address via PowerDNA Explorer
	4.4.3 Updating IP Address via Serial Port

	4.5 Network Configuration
	4.5.1 Example of Configuring Network Settings

	4.6 Troubleshooting
	4.6.1 Troubleshooting System Communicatio n
	4.6.2 Troubleshooting Communicatio n after Reset

	4.7 Updating Firmware
	4.7.1 Locating Firmware
	4.7.2 Determining Current Firmware Version
	4.7.3 Updating Firmware via PowerDNA Explorer
	4.7.4 Updating Firmware via USB and Serial

	4.8 Mounting & Field Connections
	4.8.1 Physical Dimensions

	4.9 Pinout Diagrams
	4.10 Wiring I/O Boards
	4.11 Repairing or Upgrading a Cube/RACK
	4.11.1 Removing and Replacing I/O Boards

	4.12 Disabling Writes to Flash/ EEPROM (NVRAM)
	4.12.1 Disabling NVRAM Writes (Cube)
	4.12.2 Disabling NVRAM Writes (Rack)


	Chapter 5 PowerDNA Explorer
	5.1 Overview of PowerDNA Explorer
	5.2 Launching PowerDNA Explorer
	5.3 Connecting to the Cube/ RACK
	5.4 Displaying CPU/POWER Module Diagnostics
	5.5 Obtaining a Hardware Report
	5.6 Viewing I/O Boards
	5.6.1 Interacting with I/O Boards
	5.6.2 Displaying Pinout for I/O Boards

	5.7 Setting Timeouts

	Chapter 6 Programming CPU Parameters
	6.1 Connecting to the CPU Module
	6.2 Startup Sequence
	6.3 Serial Interface Commands
	6.3.1 View Available Commands
	6.3.2 Show System Parameters
	6.3.3 Change System Parameters
	6.3.4 Reset System
	6.3.5 Change Password
	6.3.6 Display I/O Boards
	6.3.7 Display Power Diagnostics
	6.3.8 Monitor CPU Buffer Usage
	6.3.9 Change Date and Time


	Appendix A SoloX Accessories
	A.1 Cables and STPs

	Appendix B Network Interface Card Configuration
	B.1 Configuring an Ethernet Card on Windows

	Appendix C Field Replacement of Fuses
	C.1 Fuses on DNA and DNR Boards


